Microsoft Dynamics is a line of integrated, adaptable business management solutions that enables you and your people to make business decisions with greater confidence. Microsoft Dynamics works like and with familiar Microsoft software, automating and streamlining financial, customer relationship and supply chain processes in a way that helps you drive business success.

U.S. and Canada Toll Free 1-888-477-7989
Worldwide +1-701-281-6500

http://www.microsoft.com/dynamics

This document is provided “as-is”. Information and views expressed in this document, including URL and other Internet Web site references, may change without notice. You bear the risk of using it. Some examples depicted herein are provided for illustration only and are fictitious. No real association or connection is intended or should be inferred.

This document does not provide you with any legal rights to any intellectual property in any Microsoft product. You may copy and use this document for your internal, reference purposes. You may modify this document for your internal, reference purposes.

© 2011 Microsoft Corporation. All rights reserved.

Microsoft, Microsoft Dynamics, Active Directory, Excel, MSDN, SharePoint, SQL Server, Visual Studio, Windows, Windows PowerShell, Windows Server, and Windows Vista are trademarks of the Microsoft group of companies. All other trademarks are property of their respective owners.
# Table of Contents

Upgrade overview ......................................................................................................................... 6
What’s New: Upgrade ..................................................................................................................... 7
Supported upgrade paths ................................................................................................................ 8
Hardware and software requirements ............................................................................................ 9
Best practices for upgrade ............................................................................................................. 9

Before you upgrade ..................................................................................................................... 10
Clean up your data ......................................................................................................................... 11
Activate multisite functionality .................................................................................................... 11

Preprocess data on the source system .......................................................................................... 14
Install upgrade framework files .................................................................................................... 15
Install optional upgrade XPO files .................................................................................................. 17
Start the Preprocessing upgrade checklist .................................................................................... 18
Prepare for upgrade ....................................................................................................................... 20
  Check upgrade readiness ............................................................................................................ 20
  View and fix upgrade readiness issues ......................................................................................... 21
  Initialize preprocessing ............................................................................................................. 22
Prepare application data for preprocessing .................................................................................... 22
  System parameters .................................................................................................................... 23
  Set up number sequence for upgrade ......................................................................................... 23
  Company priority setup ............................................................................................................. 23
  Update country/region codes .................................................................................................... 25
  Map country/region codes ....................................................................................................... 26
  Default country/region ............................................................................................................. 26
Prepare financial dimension framework for upgrade ...................................................................... 27
Map fixed asset calendars ............................................................................................................. 28
Prepare currencies for upgrade ..................................................................................................... 28
Inventory dimension group upgrade .............................................................................................. 29
Product upgrade (preprocessing) ................................................................................................... 32
Configure site structure ................................................................................................................ 36
Map task groups to capabilities ..................................................................................................... 37
Product Builder Route nodes upgrade .......................................................................................... 37
Units ............................................................................................................................................ 38
Unit conversions .......................................................................................................................... 39
Fixed units ..................................................................................................................................... 40
Unit texts ......................................................................................................................................... 41
About purchase order upgrade ....................................................................................................... 41
User relations upgrade - invalid company users .......................................................................... 42
User relations upgrade missing contact person ............................................................................ 42
User relations upgrade duplicate user IDs .................................................................................... 42
Select which employee number to upgrade ................................................................................ 43
Preprocess data on the live system ............................................................................................... 43
Run live preprocessing scripts ..................................................................................................... 43
Country/region upgrade ............................................................................................................... 44
Create the target system ......................................................................................................................... 58
Verify that you have the required permissions for installation ............................................................... 59
Set permissions specific to upgrade ........................................................................................................ 60
Install Microsoft Dynamics AX (upgrade) .................................................................................................. 60

Upgrade the target system .......................................................................................................................... 61
Perform code upgrade ............................................................................................................................... 62
  Provide license information ..................................................................................................................... 63
  Import Microsoft AOD files into the baseline model store ................................................................. 64
  Import Microsoft-signed model files into baseline model store ......................................................... 65
  Import AOD files into the baseline model store ................................................................................. 65
  Import AOD files into the new model store ....................................................................................... 66
  Import label files into the new model store ....................................................................................... 67
  Import layer model(s) into baseline model store .............................................................................. 67
  Import layer model(s) into new model store ..................................................................................... 68
  Restart Application Object Server ..................................................................................................... 68
  Compile the application (upgrade) ....................................................................................................... 68
  Detect code upgrade conflicts ............................................................................................................. 69
  Compile into .NET Framework CIL .................................................................................................... 69
Perform data upgrade ............................................................................................................................... 70
  Provide license information ................................................................................................................ 71
  Set customer feedback options ......................................................................................................... 72
  Connect to source database .............................................................................................................. 72
  Connect to source database .............................................................................................................. 72
  Set current time zone .......................................................................................................................... 73
  Presynchronize (upgrade) .................................................................................................................... 73
  Create tables ....................................................................................................................................... 73
  Generate table mappings .................................................................................................................... 74
  Generate upgrade task prioritization ................................................................................................. 74
  Launch data upgrade ........................................................................................................................... 76
  Post journal for relief of legacy accrual of unmatched quantities ..................................................... 77
  Configure system accounts ............................................................................................................... 77
  Finalize Enterprise Portal upgrade ................................................................................................... 78
  Specify Role Center web site ............................................................................................................. 78
  Assign a primary address to parties .................................................................................................. 79
  Upgrade services and AIF .................................................................................................................. 79
  Compare data upgrade row counts .................................................................................................... 84
  Upgrade additional features ............................................................................................................... 84
  Upgrade Enterprise Portal .................................................................................................................. 85
Test the system after upgrade ............................................................... 88
Upgrade overview

This overview provides information about Microsoft Dynamics AX 2012 upgrade changes and requirements. The following sections are included:

- What’s New: Upgrade
- Supported upgrade paths
- Hardware and software requirements
- Best practices for upgrade
What's New: Upgrade

Microsoft Dynamics AX 2012 provides a new approach to upgrade that significantly reduces your company’s downtime during the upgrade process. Shorter downtime means less impact on your business operations and a lower total cost of upgrade.

Source-to-target upgrade model

Microsoft Dynamics AX 2012 uses a source-to-target upgrade model that allows business users to work with maximum efficiency during upgrade. In previous versions of Microsoft Dynamics AX, all upgrade tasks were carried out on a single production system. A substantial part of the upgrade process was spent in single-user mode, and during that time the system was offline for regular users. Difficulties that arose during upgrade had to be resolved under time pressure before normal business operations could resume. Now, with Microsoft Dynamics AX 2012, you preprocess your business data on the source system (running Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009) while the system is live, free from time pressure and without halting normal operations.

Meanwhile, you build your separate, offline target system (running Microsoft Dynamics AX 2012). When preprocessing on the source system is complete and the target system is ready, you enter single-user mode on the source system, bulk copy your data into the target system, run post-synchronization upgrade scripts, and perform testing. At this point the target system can go live.

The following diagram shows the phases of upgrade in the source-to-target model.

![Diagram of source-to-target upgrade model]

The source system (Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009) remains online during data preprocessing, and then goes offline when you enter single-user mode to prepare the data for bulk copying. When the target system (Microsoft Dynamics AX 2012) has been installed and code customizations have been applied, you bulk-copy the data into it, run post-synchronization scripts, perform final configuration tasks, test, and finally go live.

💡 Tip:

Source-to-target upgrade requires the source system and target system to be installed on separate server computers. Side-by-side installation on a single computer is possible, but should only be used for testing purposes. For more information, see Hardware and software requirements.
Checklists for each stage and type of upgrade

In previous releases of Microsoft Dynamics AX, which implemented upgrade on a single computer system, a single upgrade checklist contained all of the core upgrade tasks. Under the source-to-target upgrade model, there are now several checklists and related forms to help organize upgrade tasks on the source and target systems.

<table>
<thead>
<tr>
<th>Checklist</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preprocessing upgrade checklist</td>
<td>Tasks preparing data on the source system for the Microsoft Dynamics AX 2012 database schema.</td>
</tr>
<tr>
<td>AOD code upgrade checklist</td>
<td>Tasks involved in migrating code customizations in legacy AOD files to the Microsoft Dynamics AX 2012 model architecture.</td>
</tr>
<tr>
<td>Model code upgrade checklist</td>
<td>Tasks involved in migrating customized code in legacy models to the most recent Microsoft Dynamics AX release.</td>
</tr>
<tr>
<td>Data upgrade checklist</td>
<td>Tasks involved in upgrading data on the Microsoft Dynamics AX 2012 target system.</td>
</tr>
</tbody>
</table>

Upgrade state transfer tool

In a source-to-target upgrade, the most labor-intensive phase is data preprocessing. Assuming that you follow the best practice of performing your upgrade first on a non-production system, you will invest considerable time completing data preprocessing on a test source system. The upgrade state transfer tool allows you to capture that effort by transferring preprocessed data from a test system to your production system. For more information, see Using the Preprocessing upgrade state transfer tool.

Row count validation after upgrade

The Compare data upgrade row counts task in the Data upgrade checklist checks the data integrity on the Microsoft Dynamics AX 2012 target system following upgrade. Correctly correlated row counts among the source, shadow, and target tables suggest, but do not confirm, that bulk copy and data upgrade finished successfully. For more information, see Compare data upgrade row counts.

Supported upgrade paths

You can upgrade to Microsoft Dynamics AX 2012 directly from either Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009. If you have a version that is earlier than Microsoft Dynamics AX 4.0, you must upgrade to Microsoft Dynamics AX 2009 before you can upgrade to Microsoft Dynamics AX 2012.

For information about supported system configurations, use the following links:

- System requirements for Microsoft Dynamics AX 4.0
- Microsoft Dynamics AX 2009 System Requirements

Upgrading from a Microsoft Dynamics AX source system that uses an Oracle database

You cannot use an Oracle database with Microsoft Dynamics AX 2012. If you are upgrading from an installation of Microsoft Dynamics AX that uses an Oracle database, you must first migrate your data to a Microsoft SQL Server database, and then upgrade to Microsoft Dynamics AX 2012.
Use the Oracle to Microsoft SQL Server Data Migration Assistant for Microsoft Dynamics AX tool to migrate your data to a SQL Server database. You can download the tool and the Oracle to Microsoft SQL Server Data Migration Assistant for Microsoft Dynamics AX Installation Guide from Customer Source.

**Hardware and software requirements**
For up-to-date hardware and software requirements for Microsoft Dynamics AX, download the systems requirements document.

**Best practices for upgrade**
This topic describes practices that will improve your upgrade experience and minimize the possibility of problems along the way. We recommend reviewing and following these practices before starting your upgrade.

**Upgrade in a test environment first**
Upgrade to Microsoft Dynamics AX 2012 in a test environment before you upgrade in your production environment.

Confirm that both the source and target test systems are working correctly before you begin upgrade in your production environment. For more information about testing, see Test the system after upgrade.

💡 Tip:
Microsoft Dynamics AX 2012 allows you to preserve and reuse the preprocessed data that is created on a test source system. Using this approach reduces preprocessing time on your production source system. For more information, see Using the Preprocessing upgrade state transfer tool.

**Disk space and log size**
Verify that you have the proper amount of space on your target system hard drive and in your database transaction log.

**Database server configuration**
Ensure that Microsoft SQL Server is configured for the highest possible performance and throughput. The upgrade process should take place on a dedicated database server. If there are other applications running on the server, they will compete with the upgrade process for resources.

Review the performance benchmarks of the existing database server and determine if you need to add more resources. This might include upgrading server components such as processor(s), memory, or storage. After you upgrade or change server components, you should test the server for optimum performance before you start the Microsoft Dynamics AX upgrade process.
Before you upgrade

This section covers tasks that must be completed before you begin your upgrade to Microsoft Dynamics AX 2012. The following topics are included.

- Clean up your data
- Activate multisite functionality
Clean up your data

Before upgrading to the latest version of Microsoft Dynamics AX, we recommend that you perform maintenance on your existing Microsoft Dynamics AX database. Cleaning up the database can reduce its size, cut the time required for upgrade, and minimize the possibility of errors during data upgrade.

To help system administrators manage database clean-up, Microsoft provides the Intelligent Data Management Framework (IDMF) for Microsoft Dynamics AX. The IDMF assesses the health of the Microsoft Dynamics AX application, analyzes current usage patterns, and assists in reducing database size. This utility can be used to optimize both Microsoft Dynamics AX 4.0 and Microsoft Dynamics AX 2009 databases.

Getting and using the Intelligent Data Management Framework

Obtain the IDMF and its accompanying documentation using the following links:

- Intelligent Data Management Framework For Microsoft Dynamics AX (Installer download)
- Intelligent Data Management Framework For Microsoft Dynamics AX: Installation Guide (PDF file)
- Intelligent Data Management Framework For Microsoft Dynamics AX: Administration Guide (PDF file)

Note:
IDMF is available only through CustomerSource and PartnerSource.

Activate multisite functionality

When you upgrade to Microsoft Dynamics AX 2012, you must activate the multisite functionality for all company accounts before you upload your XPO file. The method you use to activate multisite functionality depends on the source system, and whether the Trade and Logistics licenses and configuration keys are enabled.

This topic contains information about the following upgrade scenarios:

- Activate multisite functionality when you upgrade from Microsoft Dynamics AX 2009 to Microsoft Dynamics AX 2012.
- Activate multisite functionality when you upgrade from Microsoft Dynamics AX 4.0 to Microsoft Dynamics AX 2012.
- Trade and Logistics licenses after you upgrade.

Activate multisite functionality when you upgrade from Microsoft Dynamics AX 2009 to Microsoft Dynamics AX 2012

When you upgrade from version Microsoft Dynamics AX 2009 to Microsoft Dynamics AX 2012, use the Multisite activation wizard to activate multisite functionality for each account before you start the upgrade process.
Important:
If you activate the multisite functionality before you load the upgrade XPO file, you will experience problems when you run the Multisite activation wizard.

The wizard changes the following inventory dimension settings to support the use of the multisite functionality:

- The site dimension and warehouse dimension become active in all inventory dimension groups.
- The site dimension becomes mandatory, and a site value must appear on all inventory transactions.
- A warehouse value must be entered on all issues and receipts. Blank issues and receipts are not allowed for the warehouse dimension.

Note:
To identify any transaction-related issues that will prevent the multisite functionality from being activated, you may run the Multisite activation readiness report.

Note:
To perform this task, the LogisticsAdvanced configuration key must be enabled. If the configuration key is not enabled, activation will occur in the same way as when you upgrade from Microsoft Dynamics AX 4.0.

1. Click Administration > Reports > System > Multisite activation readiness to open the report.
2. In the Site field, select a site, or enter a site, to set as the default site to use when no warehouse is associated with a transaction. If a default site is stored in the database for this company, the field may be populated with the stored value, but you can override it.
3. In the Warehouse field, enter the name of a new warehouse to set as the default warehouse to use when no warehouse is associated with a transaction. If a default warehouse is stored in the database for this company, the field may be populated with the stored value, but you can override it.

Note:
The warehouse name that you enter must be new: The warehouse name must not exist and must never have existed. There cannot be any existing transactions that reference the warehouse name that you enter here. If these conditions are not met, the program displays an error message, and the report is not generated.

4. Select whether to generate the report directly or in batch.
5. Click OK.

For more information about how to prepare master data in Microsoft Dynamics AX 2009 for multisite functionality, and how to use the Multisite activation wizard, see About sites and the multisite functionality.

Activate multisite functionality when you upgrade from Microsoft Dynamics AX 4.0 to Microsoft Dynamics AX 2012

When you upgrade from Microsoft Dynamics AX 4.0 to Microsoft Dynamics AX 2012, use the Activate multisite item on the pre-upgrade checklist to activate the multisite functionality. During the upgrade, the script assigns a default site for warehouses, work centers, and so on, and the multisite functionality is activated in all companies. All transactions are associated with a site based on the warehouses and work centers that the transactions are assigned to.
Important:
Before you upgrade, if you are using virtual companies you must make the following changes to their configuration:

- Make sure that the inventory dimensions table is not shared.
- Make sure that tables that contain inventory dimension fields are not shared.

Dimension group settings and data inconsistencies can prevent multisite functionality from becoming active. Under these circumstances, when you active the multisite functionality it can cause changes in the calculated item cost.

If a production order spans multiple sites, the order must be closed before multisite is activated in order to maintain accurate cost information. For example, on a purchase order line for 100 T-shirts, 50 T-shirts are received in one Warehouse and 30 T-shirts in another. If these warehouses are on different sites, multisite cannot be activated until that purchase order line is closed. If you do not close the purchase order line, the cost may be incorrect.

Trade and Logistics licenses after you upgrade

When you upgrade to Microsoft Dynamics AX 2012, and the Trade license and associated configuration keys are enabled, the functionality associated with the Logistics license is also enabled.
Preprocess data on the source system

This section describes data upgrade preprocessing on the Microsoft Dynamics AX source system. Data upgrade preprocessing is the most important new feature in the Microsoft Dynamics AX 2012 upgrade. By preprocessing your data, you can prepare your Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system for upgrade with less downtime than in previous versions. The following sections are included.

- Install upgrade framework files
- Install optional upgrade XPO files
- Start the Preprocessing upgrade checklist
- Prepare for upgrade
- Prepare application data for preprocessing
- Preprocess data on the live system
- Preprocess data in single-user mode
- Additional upgrade preprocessing tasks
Install upgrade framework files

The Microsoft Dynamics AX 2012 upgrade process requires manual installation of three files on your source Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system. An XPO file provides the forms and scripts that are required for data preprocessing, an ALD file provides user interface labels, and a CHM file provides user Help. The sections below describe how to install these files from your Microsoft Dynamics AX 2012 installation media.

Install and import the XPO upgrade framework file

The preprocessing XPO file installs an upgrade framework containing the following components:

- The Preprocessing upgrade checklist
- The user-input forms opened by the items in the checklist
- The preprocessing upgrade scripts
- Changes to the upgrade cockpit for upgrade readiness, live preprocessing, live delta preprocessing, and final preprocessing in single-user mode

You will import the preprocessing XPO into the USR layer on the Microsoft Dynamics AX source system. You can see the current application layer in the lower right of the Microsoft Dynamics AX client window.

**Note:**

If the current application layer is not the USR layer, you must exit Microsoft Dynamics AX and then create or modify the configuration by using the Microsoft Dynamics AX Configuration Utility. In Microsoft Dynamics AX 4.0, the path is Start > Administrative Tools > Microsoft Dynamics AX Configuration Utility. In Microsoft Dynamics AX 2009, the path is Start > Administrative Tools > Microsoft Dynamics AX 2009 Configuration. Reconfigure the client so that it opens in the USR layer.

Be sure to back up your application files (*.aod) and label files (*.ald) before you import the preprocessing XPO. You will need these files for code upgrade on the Microsoft Dynamics AX 2012 target system.

To install the preprocessing XPO on the Microsoft Dynamics AX source system, do the following:

1. Open the Application Object Tree (AOT) from its icon on the toolbar.
2. (Optional.) It is advisable to make sure that the Application Object Directory (AOD) is synchronized with the Microsoft Dynamics AX database schema before you begin to import the XPO. Synchronize them as follows:
   - Right-click Data Dictionary, and then click Synchronize.
   - Synchronization may take several minutes.
3. Click the import icon on the AOT menu bar.
4. In the Import dialog box, click Browse. The XPO is located in the DatabaseUpgrade\XPO folder on the installation media. The XPO file that you import depends on the Microsoft Dynamics AX source system that you are upgrading from.
   - On a Microsoft Dynamics AX 4.0 source system, import UpgradeAX4.xpo.
   - On a Microsoft Dynamics AX 2009 source system, import UpgradeAX5.xpo.
5. In the Import dialog box, make sure that the option Import with ID values is cleared.
6. Click OK.
7. In the Import message box, click Yes to all when you are prompted to continue the import.
8. During synchronization, the Problems during synchronization message box may warn you that tables will be dropped. You should be aware of what objects are being over-written so that you can
stop the process if necessary and merge your custom code with the XPO code for objects common to them both. To allow an object to be overwritten, click Yes.

Microsoft Dynamics AX 2009 automatically performs multiple compilation passes to make sure that validation is successful. For example, if a child object in the code is validated before its parent object, the system will display a compilation error, but in a subsequent compilation pass, the parent-child object relationship will be established and the error will no longer be displayed.

Microsoft Dynamics AX 4.0 does not automatically perform multiple compilation passes. If you import the preprocessing XPO into Microsoft Dynamics AX 4.0, you may have to manually recompile the application until no compilation errors are returned.

Install the ALD label file
The ALD file contains the labels that appear in the upgrade framework user interface. The Preprocessing upgrade checklist and associated forms will not be displayed properly without this file. To install the ALD file, do the following:

1. On your installation media, navigate to the folder DatabaseUpgrade\ALD folder and locate the ALD label file that you plan to use. Your choice will depend on the default language that you want to install. For example, the file axUPGen-us.ald provides labels in United States English for the upgrade framework forms. Each language and language region that is supported by Microsoft Dynamics AX has its own ALD file.
2. Copy axUPGen-us.ald (or other selected ALD file) to the label folder on your source system.
   - On a typical Microsoft Dynamics AX 4.0 system, copy the file to C:\Program Files (x86)\Microsoft Dynamics AX\40\Application\Appl\Standard\.
   - On a typical Microsoft Dynamics AX 2009 system, copy the file to C:\Program Files\Microsoft Dynamics AX\50\Application\Appl\Standard\.
3. Restart the application object server.

Install the CHM file for user Help
The CHM file provides the documentation that opens when you click Help next to an item on the Preprocessing upgrade checklist. To install the CHM file, do the following:

1. Locate the file UpgradePreprocessing.chm in the DatabaseUpgrade\CHM folder on your installation media.
2. Copy the file to the appropriate directory on your Microsoft Dynamics AX source system.
   - On a Microsoft Dynamics AX 4.0 system, copy the file to C:\Program Files\Microsoft Dynamics AX\40\Client\Bin\Help\EN-US\.
   - On a Microsoft Dynamics AX 2009 system, copy the file to C:\Program Files\Microsoft Dynamics AX\50\Client\Bin\Help\EN-US\.

💡 Tip:
An additional CHM file, UpgradeScripts.chm, can also be found in the DatabaseUpgrade\CHM folder. This file provides documentation of the data upgrade preprocessing scripts that are included with the upgrade framework.
**Install optional upgrade XPO files**

Some optional Microsoft Dynamics AX features require additional XPO files to be installed prior to data upgrade preprocessing. You should import these files only if you have the associated feature installed on your source Microsoft Dynamics AX system, and you want to migrate its data to Microsoft Dynamics AX 2012. The XPO files contain upgrade scripts and forms that are needed to prepare your source system data for upgrade. These optional XPO files must be installed after the upgrade framework XPO files have been installed.

This topic also covers the batch processing XPO files, which are intended to roll back any customizations that you have made to your batch processing class.

**Feature XPO files**

The optional XPO files, like the upgrade framework XPO files, are specific to an earlier version of Microsoft Dynamics AX. The correct version is signaled in the file name as follows:

- Microsoft Dynamics AX 4.0: “AX4” or “AX4.0”
- Microsoft Dynamics AX 2009: “AX5” or “AX5.0”

All of these files are located on the installation media in the DatabaseUpgrade\XPO folder.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Minimum Requirements</th>
<th>XPO</th>
<th>Components provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lean manufacturing</td>
<td>Lean manufacturing for Microsoft Dynamics AX 2009</td>
<td>SharedProject_AX50PreUpgrade_Lean.xpo</td>
<td>- Additional tasks in the Preprocessing upgrade checklist for lean manufacturing</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- User-input forms that are opened by the new checklist tasks</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Preprocessing upgrade scripts for lean manufacturing</td>
</tr>
<tr>
<td>Feature</td>
<td>Minimum Requirements</td>
<td>XPO</td>
<td>Components provided</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Process manufacturing production and logistics</td>
<td>Process Industries for Microsoft Dynamics AX 4.0 SP2, or Process Industries for Microsoft Dynamics AX 2009</td>
<td>PI_UpgradeAX4.xpo PI_UpgradeAX5.xpo</td>
<td>• An additional task in the Preprocessing upgrade checklist for process manufacturing</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• A user-input form that is opened by the new checklist task</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Preprocessing upgrade scripts for process manufacturing</td>
</tr>
<tr>
<td>Project Management and Accounting add-in</td>
<td>Professional Services Automation for Microsoft Dynamics AX 4.0 SP2, or Professional Services Automation 2009 RU4 for Microsoft Dynamics AX 2009</td>
<td>PrivateProject_AX40Preprocessing_SI.xpo SharedProject_AX50PreUpgrade_SI.xpo</td>
<td>• For Microsoft Dynamics AX 4.0, a modified upgrade script</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• For Microsoft Dynamics AX 2009, an additional upgrade readiness script</td>
</tr>
</tbody>
</table>

**Batch processing XPO files**

XPO files related to batch processing are included in the DatabaseUpgrade\XPO folder, one for each supported upgrade path:

- PrivateProject_Ax40PreUpgradeFramework_Batch.xpo
- PrivateProject_Ax50PreUpgradeFramework_Batch.xpo

These XPO files will roll back any customizations that you have made to the batch processing class on your Microsoft Dynamics AX source system. To keep data preprocessing downtime to a minimum, we recommend that you import the appropriate XPO file for your system.

**Start the Preprocessing upgrade checklist**

The Preprocessing upgrade checklist guides you through the data preprocessing tasks on the Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 source system when you upgrade to Microsoft Dynamics AX 2012.
Avoid downtime with the source-to-target upgrade model

Because upgrade for Microsoft Dynamics AX 2012 uses a source-to-target model, you can complete some of the steps in the **Preprocessing upgrade checklist** concurrently with upgrade tasks that you complete on the Microsoft Dynamics AX 2012 target system. For an overview of the upgrade process for Microsoft Dynamics AX 2012 and more information about how data preprocessing tasks on the source system relate to upgrade tasks on the target system, see [What's New: Upgrade](#).

Open the Preprocessing upgrade checklist

You install the framework for the **Preprocessing upgrade checklist** in the USR layer of the Microsoft Dynamics AX source system by importing an XPO file. This operation installs all of the forms that are required for completing the data preprocessing tasks and includes changes to the data upgrade cockpit so that you can better manage the preprocessing scripts. For information about importing the upgrade framework XPO file, see [Install upgrade framework files](#).

After the XPO file has been imported, open the **Preprocessing upgrade checklist** as follows:

1. Click the Project icon on the toolbar and navigate to *Projects* > *Shared*.
2. Expand *Shared* and locate either *Ax40PreUpgradeFramework* or *Ax50PreUpgradeFramework*, depending on the version that you are upgrading from. Right-click it, and click **Open**.
3. Locate *SysChecklist_preupgrade40* or *SysCheckList_PreUpgrade50*, depending on the version you are upgrading from. Right-click it, and click **Open** to start the **Preprocessing upgrade checklist**.

Sections and tasks in the Preprocessing upgrade checklist

The **Preprocessing upgrade checklist** displays the required and optional tasks that are involved in data upgrade preprocessing. The system records the completion of tasks and indicates this status with a check mark. The list of tasks is divided into four sections. When you open the **Preprocessing upgrade checklist**, these sections are collapsed. Expand each section to access the tasks. You can also collapse an expanded section when you have completed the tasks within it.

The following table contains the sections and types of task you will complete during data upgrade preprocessing on the Microsoft Dynamics AX source system.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare for upgrade</td>
<td>The tasks in this section test and prepare the source system for upgrade. The tasks include creating the shadow and dictionary tables where the upgrade framework will write the data that you prepare for upgrade in the next section.</td>
</tr>
<tr>
<td>Prepare application data for preprocessing</td>
<td>The tasks in this section prepare the Microsoft Dynamics AX source system data for preprocessing while the source system remains in production. Completing these tasks does not affect your production system data. When you click a task, a form opens and prompts you for information. Because these tasks require knowledge of the application data that you are preparing for upgrade, you will need guidance from a business user in each of the application areas.</td>
</tr>
<tr>
<td>Preprocess data on live system</td>
<td>These tasks run data preprocessing scripts while the source system is still live for production. The prepared data is written into shadow tables in preparation for bulk copy to the Microsoft Dynamics AX 2012 target system.</td>
</tr>
</tbody>
</table>
Microsoft Dynamics AX 2012 Upgrade Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preprocess data in single-user mode</td>
<td>These tasks apply final preparation to the source data prior to bulk copy. When you begin the tasks in this section, you start your system downtime window. Your system will not be available for production until you complete the data upgrade tasks on the Microsoft Dynamics AX 2012 target system.</td>
</tr>
</tbody>
</table>

Each task in the Preprocessing upgrade checklist links to a Help topic that explains the task and provides steps for completing it.

**Prepare for upgrade**

This section of the Preprocessing upgrade checklist contains tasks performed before data preprocessing begins. The following sections are included.

- Check upgrade readiness
- View and fix upgrade readiness issues
- Initialize preprocessing

**Check upgrade readiness**

You can check upgrade readiness before you begin upgrading data on the Microsoft Dynamics AX source system. The readiness check produces a report that identifies issues that could potentially affect data upgrade. Checks include identifying data that might cause failure of the data upgrade scripts and identifying scenarios that will need extra planning before the upgrade. No changes to data are made during the checks.

The upgrade readiness check is optional, but recommended. Running the readiness check will save time and reduce the number of times you need to run the live or delta preprocessing scripts.

**Run the upgrade readiness check**

1. In the Preprocessing upgrade checklist, click Check upgrade readiness. The Upgrade readiness form opens to display a grid of readiness scripts waiting to be run. The grid provides a description of each script, the method being invoked, the Microsoft Dynamics AX module that the script applies to, and other information.
2. Click Run to begin running the scripts.

💡 Tip:

By using the batch processing framework, you can set the number of batch server threads available to the upgrade readiness scripts. Adding additional threads up to your processing capacity will speed the completion of the scripts. For more information, see Batch processing overview.

**View readiness results and resolve issues**

After the readiness scripts have run, a list of discovered issues is available. To view and resolve these issues, open the Upgrade validation results form in either of two ways:

- Click the Readiness results button in the Upgrade readiness form.
- Click the checklist task View and fix upgrade readiness issues.
Rerun the upgrade readiness scripts

After you fix any issues that were identified by the readiness scripts, you can rerun any or all of the failed scripts. Each run of the upgrade readiness scripts results in a new report. You can refer to past readiness reports by selecting one from the Run date menu in the Upgrade validation results form.

To rerun a single script or multiple scripts when upgrading from Microsoft Dynamics AX 4.0, complete the following procedures that apply:

1. In the Upgrade readiness form, select one or more scripts and click Rerun job.
2. To rerun all readiness scripts, click Reset status and then click Run.

To rerun a single script or multiple scripts when upgrading from Microsoft Dynamics AX 2009, complete any of the following procedures that apply:

- In the Upgrade readiness form, select one or more scripts and click Rerun script.
- To rerun all failed scripts, click Rerun all failed scripts.
- To rerun all readiness scripts, click Reset status and then click Run.

**Important:**

After you resolve issues in the scripts or in the data, you can rerun the readiness check as many times as necessary until the scripts pass validation. Do not attempt an upgrade of your production data until you have identified and resolved all of the upgrade issues flagged by the upgrade readiness check.

View and fix upgrade readiness issues

The View and fix upgrade readiness issues task opens the Upgrade validation results form. Use the Upgrade validation results form as a starting point to resolve issues that are discovered when you used the Upgrade readiness form to run the upgrade readiness scripts.

**Note:**

Resolving upgrade readiness issues helps prevent failure of the upgrade later in the upgrade process.

Resolve readiness issues

The Upgrade validation results form and the Upgrade validation details form provide the information and tools that are needed to resolve readiness issues.

1. In the Upgrade validation results form, in the Validation results grid, review the scripts that ran. Each script has a status of Incomplete, Pass, Error, or Advisory.
2. Select a job that has a status of Error or Advisory in the Validation results grid to view diagnostic information in the Log grid.
3. For more information about a record that appears in the Log grid, click the Details button, if it is available.
4. To fix an issue for a record, click the Fix button and then enter any information that is required in the form that opens.
   
   If the Fix button is not available, you must either resolve the issue manually or write an upgrade script that resolves the issue. For information about scripts, see the white paper, How to Write Data Upgrade Scripts for Microsoft Dynamics AX 2012.
Initialize preprocessing

The **Initialize preprocessing** task prepares the Microsoft Dynamics AX source system for data upgrade by creating shadow and dictionary tables for all the data tables that are in the live production database. The task also initializes the preprocessing scripts. The tables that are created by this step will hold the data that is created during upgrade preprocessing. Most of the data in the shadow and dictionary tables is created by the live and delta preprocessing scripts, though some records are created by each of the other preprocessing tasks.

To initialize preprocessing and create the shadow and dictionary tables, complete the following steps:

1. In the **Preprocessing upgrade checklist**, expand **Prepare for upgrade**.
2. Click **Initialize preprocessing**.

The upgrade framework creates the shadow and dictionary tables that are not created during importation of the preprocessing XPO and, when it finishes, opens an **Infolog** form that lists all the tables that were created. This step also loads the preprocessing scripts into upgrade framework tables.

After you finish the **Initialize preprocessing** task, you can connect to the source database from the Microsoft Dynamics AX 2012 target system and begin preparing the target database for upgrade. This allows you to save time by carrying out upgrade tasks concurrently on both systems.

Prepare application data for preprocessing

This section of the **Preprocessing upgrade checklist** contains tasks that involve manual changes to application data in preparation for upgrade. The following topics are included.

- System parameters
- Set up number sequence for upgrade
- Company priority setup
- Update country/region codes
- Map country/region codes
- Default country/region
- Prepare financial dimension framework for upgrade
- Map fixed asset calendars
- Prepare currencies for upgrade
- Inventory dimension group upgrade
- Product upgrade (preprocessing)
- Configure site structure
- Map task groups to capabilities
- Product Builder Route nodes upgrade
- Units
- Unit conversions
- Fixed units
- Unit texts
- About purchase order upgrade
- User relations upgrade - invalid company users
- User relations upgrade missing contact person
- User relations upgrade duplicate user IDs
Select which employee number to upgrade

System parameters
The system language is the default language that is used by the application for text translations. Use the System parameters form to specify a shared system language.

Set the system language
1. Click System parameters to open the System parameters form.
2. Select a system language in the System language field.
3. In the Chart of accounts delimiter field, select a symbol to use as the separator between financial dimensions.

Set up number sequence for upgrade
In releases before Microsoft Dynamics AX 2012, the general ledger was always related to a single voucher, regardless of the source document. Now that some subledger journal entries can be summarized when they are transferred to the general ledger, a new numbering sequence is needed for the general journal entries.

Use the Set up number sequence for upgrade form to set up the number sequence code for the legal entities.
1. Click Set up number sequence for upgrade in the Preprocessing upgrade checklist to open the Set up number sequence for upgrade form.
2. In the Company accounts field, select the set of legal entity accounts to upgrade the number sequence for.
3. Click Set up number sequence to open the Set up number sequence form, where you can select the number sequence code to use for the general journals.
4. To use the same number sequence code for all sets of legal entity accounts, click Apply to remaining companies. Otherwise, repeat steps 2 and 3 until you have selected a number sequence code for all sets of legal entity accounts.
5. Click Set to ready for upgrade to select this checklist item as ready for upgrade.

Company priority setup
When you merge the data from more than one company, the priority of the companies determines which company’s values take priority for the data.

Use the Company priority setup form to define the priority of companies.

Note:
You must set up the company priority only if you upgrade items from more than one company.

Company priority affects product numbers and item dimension values
The company priority affects the following data when items are mapped to products:
- The sequence of product numbers
- The names and descriptions for sizes, colors, and configurations
Company priority and the sequence of product numbers

If the items that you map to a product have identical numbers but come from different companies, the sequence of product numbers is determined by the company priority. For more information, see the description of the 1:1 mapping method in Product upgrade (preprocessing).

Company priority and the names and descriptions of item dimensions

If the items that you map to a product have identical item numbers but come from different companies, the active item dimensions of these items may have different names and descriptions. When several items are mapped to one product, the names and descriptions of the item dimensions are consolidated. The names and descriptions from the company that has the highest priority are used.

Example

- Three identical items are mapped to one product. The items come from three different companies, C1, C2, and C3.
- The priority of C1 is 1, the priority of C2 is 2, and the priority of C3 is 3.
- The item has one active dimension, Color. However, the name of the dimension is not the same in the three companies.

The following table shows this setup.

<table>
<thead>
<tr>
<th>Company</th>
<th>Item</th>
<th>Item dimension</th>
<th>Item dimension name</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>INV-1000</td>
<td>Color</td>
<td>Red</td>
</tr>
<tr>
<td>C2</td>
<td>INV-1000</td>
<td>Color</td>
<td>_Red</td>
</tr>
<tr>
<td>C3</td>
<td>INV-1000</td>
<td>Color</td>
<td>“Red”</td>
</tr>
</tbody>
</table>

The items are mapped to one product, PROD-1000. The name of the Color dimension is consolidated to Red, because this name is used in C1, the company that has the highest priority.

Company priority and product translations

When items are mapped to products, product translations are derived in the same way as dimension names and descriptions. When several items are mapped to one product, if more than one translation into a particular language exists for the items, the translations are consolidated. The translation from the company that has the highest priority is used.

The initial company takes priority

When a mapping is completed, there is always a one-to-one relationship between items and products. Furthermore, an item is always initiated from one company. An item’s initial company is the company where the item was first created. Therefore, if you map items to existing products by aligning the product numbers in the Product upgrade form, the initial company always has the highest priority, regardless of how company priority is set up.

Example

In the previous example, product PROD-1000 inherited the dimension name from item INV-1000 in company C1, because C1 had the highest company priority. You now want to map an additional item, INV-A100, to PROD-1000. Item INV-A100 comes from another company, CA, which has a higher priority than C1. However, C1 takes precedence when properties such as the dimension name are copied to PROD-1000, because C1 is assigned as the initial company of PROD-1000. Therefore, when properties are copied, the order of priority is C1, CA, C2, and C3.

The following table shows this setup.
Update country/region codes

A list of default country/region codes is delivered in Microsoft Dynamics AX 2012. This list also includes 18 default address formats and component information for the countries/regions, such as state/province, county, city, district, and ZIP/postal code.

If you want to change the default address format that is assigned to a country/region code, you can select another address format in the Address format column. For example, the country/region for Antarctica has a default address format of 0001. This means that the address components are displayed in the following way:

- **Street name**
- **City, State ZIP/postal code**
- **Country/region**

You might select to change the default address format to 0013. After you make the change, the address components are displayed in the following way:

- **Street name**
- **City, ZIP postal code**
- **Country/region**

Use this form to view default country/region codes and the corresponding address formats. You can also add new country/region codes and select corresponding address formats for them. The country/region codes and address formats will be used for address records in Microsoft Dynamics AX 2012.

Note:

In the Map country/region codes form, you will map the countries/regions from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 to the countries/regions that are displayed in the form. You cannot map more than one country/region code from the same company to a country/region code listed in the Country/region codes form. You must manually create a unique country/region code for all countries/regions in the same company before the upgrade.

1. In the Preprocessing upgrade checklist, click Update country/region codes to open the Country/region codes form.
2. Review the list and verify the short name, long name, and address format for the countries/regions.
   - You can modify the short name and long name by editing the field. The countries/regions that you add to this list will appear in Microsoft Dynamics AX 2012 in the user language. Any other translations must be entered manually in Microsoft Dynamics AX 2012 after upgrade is completed.
• You can select a different address format in the Address format field. This list includes default address formats and any address formats from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009.

3. To add a country/region code that was used in Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 but does not appear in the list, press CTRL+N and do the following:
   a. In the Country/region code field, enter the country/region code that you want to add.
   b. Enter the short name and long name for the country/region, and then in the Address format field, select the address format that corresponds to the selected country/region.

4. Click Set to ready for upgrade.

Map country/region codes

In Microsoft Dynamics AX 4.0 and Microsoft Dynamics AX 2009, more than one country/region code could be assigned to a country/region. Only one country/region code per company from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 can be mapped to a country/region code in Microsoft Dynamics AX 2012. Before you upgrade to Microsoft Dynamics AX 2012, all country/region codes in your current version of Microsoft Dynamics AX must be mapped to a country/region code in Microsoft Dynamics AX 2012.

For example, in Microsoft Dynamics AX 4.0, you may have assigned the country/region code GBR to both Great Britain and the United Kingdom. Before you can upgrade to Microsoft Dynamics AX 2012, you must reassign the GBR code to one of those countries/regions and assign a new unique country/region code to the other country/region.

Use this form to map the country/region codes in all companies in Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 to the country/region codes in Microsoft Dynamics AX 2012. All country/region codes must be mapped from the earlier version to Microsoft Dynamics AX 2012.

⚠️ Warning:
If your Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 application contains customized code that affects the handling of country/region data, you might encounter errors during data preprocessing. If you encounter these errors, you will need to write an upgrade preprocessing script to correctly map your existing data to the Microsoft Dynamics AX 2012 schema. For more information, see the white paper How to Write Data Upgrade Scripts for Microsoft Dynamics AX 2012.

1. In the Preprocessing upgrade checklist, click Map country/region codes to open the Country/region code mapping form.
2. For each country/region in the grid, in the Mapped country/region column, use the menu to select the Microsoft Dynamics AX 2012 country/region code that corresponds to the country/region code from your earlier version of Microsoft Dynamics AX. The country/region code from your earlier version is displayed in the Country/region code column.
3. After you map all the country/region codes from the earlier version of Microsoft Dynamics AX to the country/region codes in Microsoft Dynamics AX 2012, click Set to ready for upgrade.

Default country/region

In Microsoft Dynamics AX 2012, all postal addresses must have a corresponding country/region. Use this form to validate and update the default country/region code for each company in your organization. When you upgrade from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009, the country/region
Prepare application data for preprocessing section

that you select here for a company becomes the country/region for address records in that company that
do not have a specified country/region. After you have completed the Prepare application data for
preprocessing section of the Preprocessing upgrade checklist, you can use the Addresses with no
country/region form to change the country/region for an address record.

1. In the Preprocessing upgrade checklist, click Default country/region to open the Default
country/region for addresses form.
2. Review the country/region that is assigned to the companies in the list. This is the country/region
code that will be assigned to any address that does not already have a country/region code assigned.
3. To change the country/region for a company, select a country/region in the Default country/region
code field.
4. After you have verified the country/region defaults for each company, click the Set to ready for
upgrade button.

Prepare financial dimension framework for upgrade

A main account category is a classifier of a main account. A financial dimension is a financial data classifier
that is created from the parties, locations, products, and activities in an organization, and that is used for
management reporting.

In Microsoft Dynamics AX 2009, you could create ledger account categories and financial dimensions for
each company. In Microsoft Dynamics AX 2012, the main account categories and financial dimensions that
you create are shared, and can be used by any of the legal entities that are set up in Microsoft Dynamics
AX.

Note:
Dimension focuses have been renamed to financial dimension sets and are shared by the legal
entities that are set up in the Legal entities form. Therefore, the financial dimension sets can be
used by any of those legal entities. Financial dimension sets in Microsoft Dynamics AX 2012 differ
from the dimension sets in previous releases.

Use the Prepare financial dimension framework for upgrade form to select the main account
categories and financial dimension sets that will be shared by the legal entities.

1. Click Prepare financial dimension framework for upgrade to open the Prepare financial
dimension framework for upgrade form.
2. In the Company accounts field in the Ledger account categories field group, select the company
account that contains the main account categories that will be available as shared main account
categories.

Note:
This field is available only if you are upgrading from Microsoft Dynamics AX 2009.

3. In the Generate shared dimension focuses field, select how to create financial dimension sets:

- For each company account – All the financial dimension sets that currently are set up for the
  accounts in each company will be available as shared financial dimension sets.
- Specific company account – Only the financial dimension sets for the accounts in the company
  that you select in the Company accounts field in the Dimension focuses field group will be
  available as shared financial dimension sets.

4. If you selected Specific company account, select the company account that contains the financial
dimension sets that will be shared. Otherwise, continue to step 5.
5. Optional: Click **Ledger account categories upgrade validation** to display the ledger account categories that have upgrade errors.

   **Note:**
   This button is available only if you are upgrading from Microsoft Dynamics AX 2009.

6. Optional: Click **Dimension focus upgrade validation** to display the shared financial dimensions sets and the upgrade error status of each financial dimension set.

7. Click **Set to ready for upgrade** to select this checklist item as ready for upgrade.

   **Warning:**
   Do not change financial dimension names after you start the Preprocessing upgrade checklist, and before the update is completed.

**Map fixed asset calendars**

When you upgrade to Microsoft Dynamics AX 2012, you must use the **Upgrade fixed asset calendars** form to upgrade existing fixed asset calendars to fiscal calendars that can be shared by multiple legal entities.

You can then use the **Ledger** form in Microsoft Dynamics AX 2012 to select a fiscal calendar.

   **Note:**
   When you upgrade fixed asset calendars, each new fiscal calendar must have a unique name.

1. Review the list of companies that use fixed asset calendars, and then review the names of the fixed asset calendars in the **Calendar name** column.
   - If all the calendar names in the **Calendar name** column are unique, you do not need to make any changes.
   - If two or more calendars have the same name in the **Calendar name** column, a new name must be assigned so that each calendar name is unique. For each duplicate calendar name, a new name is suggested in the **New name** column. You can change these suggested names.

2. When you are finished, click **Set to ready for upgrade** to upgrade the fixed asset calendars to fiscal calendars.

**Example**

Both Legal entity A and Legal entity B have fixed asset calendars named RBA01 (Reducing Balance Asset 1). Your task is to upgrade the fixed asset calendars to fiscal calendars. In the **New name** column, you change the names of the calendars to RBA01-A and RBA01-B. After you upgrade the calendars, the calendars are shared and can be used by any legal entity or by multiple legal entities.

**Prepare currencies for upgrade**

In releases previous to Microsoft Dynamics AX 2012, you could set up currencies for each company. In Microsoft Dynamics AX 2012, the currencies that you set up are shared by the legal entities that are set up in the **Legal entities** form, so the currencies can be used by any of those legal entities.

Use the **Prepare currencies for upgrade** form to select the currencies, a triangulation currency, and the exchange rates that will be shared by the legal entities.

1. Click **Prepare currencies for upgrade** to open the **Prepare currencies for upgrade** form.
2. In the **Generate shared currencies** field, select which currencies will be available as shared currencies:
• **For each company** – All the currencies that currently are set up in each company will be available as shared currencies.

• **Specific company account** – Only the currencies for the company that you select in the **Company accounts** field in the **Currencies** field group will be available as shared currencies.

3. If you selected **Specific company account**, select the company account that contains the currencies that will be shared.

4. In the **Company accounts** field in the **Triangulation currency** field group, select the company account that contains the triangulation currency to upgrade. This triangulation currency will represent the euro currency.

5. In the **Generate shared exchange rates** field, select which exchange rates will be available as shared exchange rates:

   • **For each company** – All the exchange rates that currently are set up in each company will be available as shared exchange rates.

   • **Specific company account** – Only the exchange rates for the company that you select in the **Company accounts** field in the **Generate shared exchange rates** field group will be available as shared exchange rates.

6. If you selected **Specific company account**, select the company account that contains the exchange rates that will be shared.

7. Optional: Click **Currency code upgrade validation** to display the shared currency codes and the upgrade error status of each code.

8. Click **Set to ready for upgrade** to select this checklist item as ready for upgrade.

### Inventory dimension group upgrade

Use the **Preprocess inventory dimension groups** form to define how company-specific inventory dimension groups are consolidated into a set of inventory dimension groups that are shared between companies.

#### The inventory dimension grouping is new

In Microsoft Dynamics AX 2012, the inventory dimension groups are split into three groups: product, storage, and tracking. The groups contain the following dimensions.

<table>
<thead>
<tr>
<th>Group</th>
<th>Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Color, Size, Configuration</td>
</tr>
<tr>
<td>Storage</td>
<td>Site, Warehouse, Location, Pallet ID</td>
</tr>
<tr>
<td>Tracking</td>
<td>Batch number, Serial number</td>
</tr>
</tbody>
</table>

The **Color, Size, and Configuration** dimensions, which were previously called item dimensions, are now found in the product dimension group. Furthermore, the storage dimensions are now divided between a storage dimension group and a tracking dimension group.

Each inventory dimension group that already exists must be mapped to one of the new product, storage, or tracking dimension groups.

☑ **Note:**

If an inventory dimension group has no active item dimensions, the mapping methods do not create a product dimension group. A product dimension group cannot be created if there are no active dimensions.
Map preexisting company-specific inventory dimension groups to the new dimension groups

When you start preprocessing inventory dimension groups, the Preprocess inventory dimension groups form contains a list of all preexisting inventory dimension groups from all companies. You must map the company-specific inventory groups to the new product, storage, and tracking dimension groups.

1. Click Inventory dimension group upgrade to open the Preprocess inventory dimension groups form.
2. Click Dimension group mapping, and then select a method of mapping. The following options are available:
   - **Map dimension groups 1:1** – For each preexisting inventory dimension group, create three dimension groups: a product dimension group, a storage dimension group, and a tracking dimension group. The active dimension in each new dimension group corresponds to one type of active dimensions in the original, company-specific inventory dimension group. The names of the new dimension groups consist of consecutive numbers prefixed by PDG_, SDG_, or TDG_.
     
     ![Note:](image)
     
     You can change this naming convention in the Map dimension groups 1:1 form.
   - **Map dimension groups ID** – For each preexisting inventory dimension group, create product, storage, and tracking dimension groups, just as when you use the Map dimension groups 1:1 method. The difference between this method and the 1:1 mapping method is the naming convention. When you use this method, the names of the new dimension groups are copied from the original, company-specific inventory dimension groups.
     
     ![Note:](image)
     
     Consolidating inventory dimension groups from different companies that use identical naming conventions for dimension groups can cause validation errors. For example, if both company 1 and company 2 have an inventory dimension group that is named DimGroup1, the identical names can cause a validation error. The active dimensions and the setup of the active dimensions must be identical. Otherwise, the upgrade consolidation is not successful.
   - **Map dimension groups by setup** – Map dimension groups according to the setup of the active dimensions and settings of the inventory dimension groups. For more information, see the next section.

3. Click Dimension groups to view and change the names and descriptions of the new dimension groups.
   a. To change the name of a new dimension group, you must first change the name of the original inventory dimension group in the Preprocess product dimension groups, Preprocess storage dimension groups, or Preprocess tracking dimension groups form.
   b. Then select the new name for the product, storage, and tracking dimension groups in the Preprocess inventory dimension groups form.
4. Click Validation report to check for validation errors before you set the dimension groups to ready for upgrade.
5. After you resolve all validation errors, click Set to ready for upgrade.

Mapping according to the setup of the inventory dimension groups

You can map the new, shared product, storage, and tracking dimension groups according to the active item and storage dimension setup in the original inventory dimension groups. For each preexisting inventory dimension group, the program proposes a product dimension group, a storage dimension
group, and a tracking dimension group. When new groups are created, the configurations in all the existing inventory groups are considered. The new product, storage, and tracking groups are based on information that is merged from all the existing inventory groups.

When you map inventory dimension groups by setup, the program may propose the same product, storage, or tracking dimension group for more than one inventory dimension group. This is because the existing inventory dimension groups have the same setup of active product, storage or tracking dimensions.

**Example: Map inventory dimension groups by setup**

In the following example, three company-specific inventory dimension groups, InvGroup1, InvGroup2, and InvGroup3, are consolidated into product, storage, and tracking dimension groups.

💡 **Tip:**

The three inventory groups can come from three different companies, or they can all come from the same company.

The following table shows the setup of the active dimensions in the three inventory dimension groups.

<table>
<thead>
<tr>
<th>InvGroup1</th>
<th>InvGroup2</th>
<th>InvGroup3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Size</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>Site</td>
<td>Site</td>
<td>Site</td>
</tr>
<tr>
<td>Warehouse</td>
<td>Warehouse</td>
<td>Warehouse</td>
</tr>
<tr>
<td>Serial number</td>
<td>Serial number</td>
<td></td>
</tr>
<tr>
<td>Batch number</td>
<td>Batch number</td>
<td></td>
</tr>
</tbody>
</table>

The following table shows the dimension groups that Microsoft Dynamics AX proposes, based on the setup of the preexisting company-specific inventory dimension groups.

- For the item dimensions, **Color**, **Size**, and **Configuration**, the setup of active dimensions in InvGroup2 differs from the setup in InvGroup1 and InvGroup3. Therefore, two product dimension groups are created.
- For the storage dimensions, **Site** and **Warehouse**, the setup of active dimensions is identical in InvGroup1, InvGroup2, and InvGroup3. Therefore, one storage dimension group is created.
- For the **Batch number** and **Serial number** dimensions, the setup of active dimensions is different in InvGroup1, InvGroup2, and InvGroup3. Therefore, three tracking dimension groups are created.
Product upgrade (preprocessing)

In Microsoft Dynamics AX 2012, there are new processes for handling items. A new structure requires any item that is configured in a company to be based on a product definition. Therefore, any item that is handled in inventory, or during the purchase or sales process, must be associated with a product definition. Product definitions reside at the shared level.

You use the Product upgrade form to define how existing, company-specific items are mapped to products.

Note:
Before you can start mapping items to products, you must set the company’s priority and complete the preprocessing of inventory dimensions.

New product concepts

To understand how items are mapped to products, you must be familiar with the following new concepts that are introduced in Microsoft Dynamics AX:

- Product master – A standard or functional representation of a product that is the basis for configuring product variants.
- Product variant – A configuration of a product master.
- Distinct product – A uniquely identifiable product.

Items are upgraded to product masters and distinct products

Existing items that have active item dimensions are created as product masters. Items that do not have active item dimensions are created as distinct products.

Combinations of item dimensions are created as variants

When you map items to products, combinations of item dimensions are created as product variants. Therefore, product variants are created for product masters, and product masters are based on items that have active item dimensions.

Tips:
In the Product upgrade form, click View > All item dimension combinations to view the combinations of item dimensions for items that have active item dimensions.

In the Product preview form, click Variants to view product variants.

The mapping process

There are two mapping methods. The method that you choose determines the level of manual work that you must do to map items. Your choice depends on factors such as the number of items and the number of different companies for which items must be merged. For example, if you upgrade two lists of items, and each list contains identical items, you may want to map by item number. If you map by item number, items that have identical item numbers are merged. You can complete a clean-up of the data after the mapping instead of after the upgrade. However, when you map by item number instead of using the 1:1 method, there is a higher risk of validation errors. There is also a greater likelihood that you must perform manual work later.
Synchronize
When you synchronize items, you synchronize the data in the upgrade environment with the existing data in the system.

Note:
The first time that you open the Product upgrade form, the fields are empty. The fields are not populated until you synchronize items.

Synchronize items
1. Click Product upgrade to open the Product upgrade form.
2. Click Synchronize items to synchronize the items in the upgrade environment.

Notes:
You cannot continue the mapping process until the synchronization is completed.
If item data is changed during the upgrade process, you can synchronize items at any time to make sure that the upgrade environment includes the most recent data.

Map items
You can choose between the following two mapping methods:

- **Map all items 1:1** – Each item is mapped to a unique product of the Product master or Distinct product subtype. The item number is replicated in the new product number. The name and search name of the product are identical to the name and search name of the item.
- **Map all items by item number** – All items that have identical item numbers are mapped to the same product. For example, if you map items from two different companies, items that have the same item number can be mapped to one product.

Note:
If two items that have identical item numbers have different names or different setups for their item dimensions, for example, you receive a validation error. The solution depends on the problem. If the names of the two items are different, you can change the text in the Product name fields in the Product preview form. If the dimensions are different, you must change the original data in the system. However, you may not be able to make the changes if transactions exist in the system.

Map items 1:1
1. In the Product upgrade form, click Product mapping, and then select Map all items 1:1.
2. In the Map all items 1:1 form, enter a prefix in the Product number prefix field, and then enter an initial number in the Initial number field.

Note:
The numbering convention that you define in the Product number prefix and Initial number fields is only applied if you map items that have identical numbers but come from different companies. For these items, the product numbers are replaced with numbers based on this convention.
The sequence of product numbers is based on the company’s priority. To view or change the priority of companies, click View > Company priority setup.
Example

Three items from three different companies have the item number XL-1000. For the numbering convention, the product number prefix is PXL, and the initial number is 99.

The three item numbers come from three companies, C1, C2, and C3. The priority of C1 is 1, the priority of C2 is 2, and the priority of C3 is 3.

The following product numbers are generated:

- Item XL-1000 from company C1 – Product number: XL-1000
- Item XL-1000 from company C2 – Product number: PXL99
- Item XL-1000 from company C3 – Product number: PXL100

Map items by number
1. In the Product upgrade form, click Product mapping, and then select Map all items by item number.
2. Click OK to continue.

Approve the mapping

Product mappings must be approved before you can set the items to ready for upgrade. You can approve all mappings, or reverse the approval of all mappings, from either the Product upgrade form or the Product preview form. You can approve or reverse the approval of selected items only from the Product preview form.

Approve or reverse all mappings from Product upgrade
1. In the Product upgrade form, click Product mapping approval.
2. Select Approve all mappings to approve all mappings. Select Reverse all mapping approvals to reverse the approval of all mappings.

Approve or reverse all or selected mappings from Product preview
1. In the Product upgrade form, click View > Product preview to open the Product preview form.
2. Click Product mapping approval and select one of the following submenu commands:
   - Select Approve all mappings to approve all mappings.
   - Select Reverse all mapping approvals to reverse the approval of all mappings.
   - Select Approve selected mappings to approve mappings of the products that you have selected in the Product preview form.
   - Select Reverse selected mapping approvals to reverse the approval of mappings for the products that you have selected in the Product preview form.

Clear all product numbers

- In the Product upgrade form, click Clear all product numbers to remove all product numbers from a previous mapping.

Validate mappings

After you map items and approve the mappings, you can request a validation report. The validation report shows the validation errors that are caused by inconsistencies or data violations, such as when two items that have identical names are mapped to the same product. If you mapped all items by item number, you
may have to repeat the mapping process and the validation several times to resolve all of the validation errors. You must repeat the mapping process and the validation until all errors are resolved.

✔ Note:
   You cannot complete the upgrade until all validation errors are resolved. In addition to validation errors, you may receive validation warnings. Validation warnings are just warnings about inconsistent data. The upgrade can be completed if there are validation warnings.

**Validate all product mappings**

1. In the **Product upgrade** form, click View > **All validation results**.
2. In the **Product validation** form, click **Validate all** to update the view.

✔ Note:
   You must click **Validate all** to update this form, even if you are opening the form for first time, or if you previously validated the mappings.

**Set to ready for upgrade**

- In the **Product upgrade** form, click **Set to ready for upgrade** to indicate that the products are ready to be upgraded.

✔ Note:
   You must approve all product mappings before you set products to ready for upgrade. If validation errors exist, you must resolve the errors before you can continue.

**Troubleshoot product variants with no association to a product master**

On rare occasions, the preexisting data set can include item dimension combinations where one or more of the corresponding item dimensions are inactive on the associated dimension group.

If this applies to your data set, we recommend that before you start to preprocess your data, you consider how you want to handle these item dimension combinations.

In the upgrade process, all item dimension combinations are created as product variants. Product variants depend on an association with a product master. If the potential product masters for the product variants are based on items with inactive item dimensions, these items are mapped to distinct products rather than to product masters. Product variants that lack an association with a product master prevent the data from being properly upgraded.

To resolve this issue we recommend the following:

- If possible, on the dimension groups, activate any item dimensions that are associated with item dimension combinations.
- If you cannot activate the dimensions, you can try to delete the item dimension combinations. Before you delete, make sure that you back up your data.

**Product preview**

Use the **Product preview** form to view products, and to perform tasks on all products or selected products. From this form, you can see how items are mapped to products of the Distinct product or Product master subtype. You can also lock products, approve the mapping of products, and view product details.
Some tasks, such as product mapping and product approval, can be completed in both the Product upgrade form and the Product preview form. However, the two forms are not identical. For example, the perspective in the forms is different. In the Product preview form, you view data from the product’s perspective. However, in the Product upgrade form, you view data from the item’s perspective. In addition, you can use the Product preview form to approve the mapping of selected products. However, you approve product mappings from the Product upgrade form, the approval applies to all items in the form.

View mappings and perform tasks on products
1. In the Product upgrade form, click View > Product preview to open the Product preview form.
2. Click the buttons to complete the following tasks:
   - **Product mapping** – Map all items, either by item number or by using the 1:1 method.
   - **Product locking** – Lock all products or selected products. Locked products are disregarded during the mapping process. When you consider the mapping of a set of products final, you can lock the products. The locked products are not affected if you later repeat the mapping process.
   - **Product mapping approval**: – Approve or reverse the approval of the mappings for all items or selected items.
   - **Validation** – Validate all mappings or selected mappings.

   **Tip:**
   You can validate mappings at any time. When you validate a mapping, you receive a list of validation errors and guidelines to help you resolve the errors.

   - **Variants** – View the product variants that were created for products of the Product master subtype.

   **Tip:**
   The variants of a product correspond to the combinations of item dimensions for an item.

   - **Configurations, Sizes, and Colors** – View the setups for configuration, size, and color that are inherited from the items.
   - **Translations** – View any text translations in different languages that were set up for the items.

**Configure site structure**
This topic explains how to define a structure for your sites, warehouses, and resource groups. Additionally, you can specify the default site, warehouse, and the fallback warehouse to assign to transactions for which this information is not available and cannot be deduced.

**To configure the site structure**
1. In the Configure site structure form, in the Filter by company field, select the company account for which you want to define a site structure.
2. In the Site field, enter a unique identifier for the site.
3. In the Name field, enter the name of the site.
4. To assign a warehouse or resource to this site, click the Warehouses or Work center groups tab, and then select the site in the Site field.
5. To specify the default site, warehouse, and fallback warehouse for this site, click the Defaults tab and then select the site in the Default site, Default warehouse, or Fallback warehouse field.
Map task groups to capabilities

Use this item on the preprocessing checklist to specify the capability that you must have in order to convert task groups during the upgrade process. Task groups are not available in the target system.

Update task groups to capabilities

1. On the Preprocessing upgrade checklist, click Prepare application data for preprocessing > Task group upgrade
2. Select a task group, and then click the Map task groups button and choose one of the following conversion methods:
   - To map a task group conversion manually, select the task group and then enter a unique identifier in the Capability field for each task group.
   - To automate the mapping and use the task group ID as the identifier for the capability, click the Map task groups button and select Map task groups by task group ID across all company accounts.
   - To automate the mapping using a 1:1 relationship between task groups and capabilities, click the Map task groups button and select Map task groups 1:1.

Note:
To delete existing mapping information, click the Map task groups button and select Clear mapping of all task groups.

Product Builder Route nodes upgrade

This topic describes how to map modeling variables assigned to product models and nodes in the modeling tree to fixed values during the upgrade process. The target system does not support modeling variables. Therefore, existing modeling variables must be mapped to fixed values. The fields that are available on the right side of the form can vary, depending on the modeling variables that are allocated for each product model.

Example
If a modeling variable is allocated for a resource in a product model, the Resource (Variable) field shows the modeling variable. You must then select the fixed resource that you want to map the variable to in the Resource field.

To map route variables for upgrade

1. Click Prepare application data for preprocessing > Product builder route nodes upgrade.
2. Select a product model in the grid on the left side of the form. Depending on the modeling variables that require mapping, do one of the following in the available fields.
   - In the Resource field, select the fixed resource to which you want to map the modeling variable shown in the Resource (Variable) field.
   - In the Load field, enter a number for the load that you want to map the modeling variable to.
   - In the Qty. of Resources field, enter a number for the quantity of resources that you want to map the modeling variable to.
   - In the Job Requirement field, enter a number for the job requirement that you want to map the modeling variable to.
3. To mark this item on the preprocessing checklist as completed, and continue to the next item on the preprocessing checklist, click the Set to ready for upgrade button.
Units
A unit of measure is a standard base or a derived division of quantity that is used for measurement or exchange. For example, when you enter an order in Microsoft Dynamics AX, you specify both a quantity and the unit of measure that the quantity represents.

Use the Preprocess units form to define how existing company-specific units of measure are mapped to shared units of measure.

Note:
You must set a system language before you can start this task.

Shared units of measure replace company-specific units of measure
Shared units of measure replace the company-specific units of measure that are used in previous versions of Microsoft Dynamics AX. You must map each company-specific unit of measure that exists to a unit of measure that is shared across companies.

Note:
You can change a shared unit of measure so that it differs from the company-specific unit of measure in the number of decimal places or in the description. The existing data in the system is updated so that it reflects the changes.

Map company-specific units of measure to shared units of measure
When you start preprocessing units of measure, the Preprocess units form lists all units of measure from all existing companies. When you map units of measure from different companies to one set of shared units of measure, you must align information such as the number of decimal places. This information must be aligned for each unit of measure.

1. Click Units to open the Preprocess units form.
2. In the Unit (shared) field, select the symbol that represents the shared unit of measure. Repeat this step for each line.

Tip:
Click Automatic assignment to automatically assign each company-specific unit of measure to a new shared unit of measure. When you click Automatic assignment, the value of the Unit field is copied to the Unit (shared) field on all lines where the Unit (shared) field is blank. However, you can manually change the value of the Unit (shared) field.

Tip:
We recommend that you use the international symbols for units of measure. For more information, see General Tables of Units of Measurements.

3. Confirm that the values of the Description and Decimals fields are the same for every company. To consolidate a unit of measure from two companies, you select the same unit symbol in the Unit (shared) field on each line. The values of the Description and Decimals fields may be different on each line. You must align the values of these fields for each shared unit of measure. When the values of these fields are identical, the system can identify the lines that must be merged during the upgrade.

Note:
If units of measure from different companies have identical unit symbols, but the values of the Decimals, System of units, and Description fields are different, the mapping cannot be
completed. In the **Preprocess units** form, you can use one of the following methods to resolve the issue:

- Change the values of the **Decimals**, **System of units**, and **Description** fields, so that they are the same for all units that have the same symbol.
- Change the values of the **Unit (shared)** fields, so that they are different for the units that have different properties.

The solution that you choose depends on the company setup. If the properties of the units of measure differ by mistake, you can align the values of the fields for the properties. If the properties must remain different, you must change one of the unit symbols.

**Tip:**
To filter the contents of a column, select a field, and then click **Filter By Selection** on the toolbar. For example, to identify all lines that use the unit symbol kg, select the **Unit (shared)** field that has this value.

4. In the **Unit class** field, select a classification for the unit of measure.

**Tip:**
The unit class represents a logical grouping of units of measure, such as area or quantity. The unit classes specify base units and standard units. Base units can be used to streamline the setup of a conversion.

**Note:**
When you start preprocessing units of measure, all units that are derived from existing units of measure are assigned to the **Undefined** class. For each shared unit of measure, you must select a unit class other than **Undefined**. For a shared unit of measure, the unit class must be identical on every line that is associated with the unit of measure.

5. In the **System of units** field, verify that the appropriate system of units is applied.
The field is set to **None** when company-specific units of measure are created manually. For units such as box and piece, **None** is an appropriate system of units. However, if **None** is not appropriate for a unit of measure, select **Metric** or **United States customary units**. Examples of units of measure that use the **None** category are Box and Pieces.

**Note:**
For a shared unit of measure, the system of units must be identical on every line that is associated with the unit of measure.

6. Click **Validate** to check for validation errors before you set the units of measure to ready for upgrade.
7. After you resolve all of the validation errors, click **Set to ready for upgrade**.

**Unit conversions**
Unit conversions define formulas for converting between units of measure. One unit conversion can be associated with each unit of measure.

Use the **Preprocess unit conversions** form to define how you want company-specific unit conversions that exist for company-specific units of measure to be consolidated for shared units of measure.

**Note:**
You must complete the definition of shared units of measure before you can start this task. Click **Units** to define shared units of measure.
Company-specific unit conversions are consolidated

Each company-specific unit of measure that was created in earlier versions of Microsoft Dynamics AX may have an associated unit conversion. The shared units of measure that you define are based on company-specific units of measure. The associated unit conversions may differ from company to company. The unit conversions can differ in one or more of the following aspects: factor, additional quantity, or rounding information. You must consolidate the unit conversions for each shared unit of measure.

Note:
You may change the factor, additional quantity, or rounding information for a shared unit conversion, so that it differs from the factor, additional quantity, or rounding information in the company-specific unit conversion. In this case, the existing data in the system is updated to reflect the changes.

Consolidate the unit conversions for the shared units of measure

When you start preprocessing unit conversions, all conversions for each shared unit of measure are listed in the Preprocess unit conversions form. Before you can consolidate the list of conversions, you must make sure that the factor, additional quantity, and rounding information are identical for each unit conversion. For example, if the conversion from centiliters (cl) to deciliters (dl) is specified on two lines, and the rounding information is different on each line, you must align the rounding information for the cl to dl conversion.

1. Click Unit conversions to open the Preprocess unit conversions form.
2. In the Factor, Additional quantity, and Round-off fields, verify that the information is identical if more than one line has the same conversion formula.
3. Click Validate to check for validation errors.
4. After you resolve all validation errors, click Set to ready for upgrade.

Fixed units

System units define the units for length, mass, and volume that appear as suggested units of measure in Microsoft Dynamics AX.

Use the Preprocess fixed units form to set up the system units.

Note:
You must define shared units of measure before you can begin this task.

Shared system units replace fixed units

System units that are shared across all companies now replace fixed units, which were used in earlier versions of Microsoft Dynamics AX.

Set up system units
1. Click Fixed units to open the Preprocess fixed units form.
2. In the **Length**, **Mass**, and **Liquid volume** fields, select the system units that you want to use.

   **Note:**
   The units that you select must belong to the unit classes for length, mass, and liquid volume. You assign units of measure to unit classes in the **Preprocess units** form.

3. Click **Validate** to check for validation errors.
4. After you resolve all validation errors, click **Set to ready for upgrade**.

**Unit texts**

Unit texts are printed on external documents such as invoices. If no unit text is associated with a unit of measure, the symbol of the unit of measure is applied.

Use the **Preprocess unit texts** form to define how company-specific unit texts that exist are consolidated to a set of shared language-specific unit texts.

From Microsoft Dynamics AX onwards, the language is shared between companies and there is only one shared language. For this reason, text in external documents is not automatically printed in company-specific languages. To accommodate this change and preserve a representation of, for example units of measure, in different languages, you must create new unit texts. The new unit texts must be created for each unit of measure in each of the languages that you want to be represented.

**Set the unit texts for different languages**

When you start preprocessing unit texts, all unit texts associated with each unit of measure are listed in the **Preprocess unit texts** form. In cases where there is more than one unit text per language for a shared unit of measure, the texts must be aligned so that there is only one text per language.

1. Click **Unit texts** to open the **Preprocess unit texts** form.
2. Verify the text in the **Unit** field. If there is more than one unit text per language associated with a unit, you must align the texts.

   **Tip:**
   To align unit texts, change the content of the **Unit** fields.

3. Click **Validate** to check for validation errors before you set the unit texts to ready for upgrade.
4. Click **Set to ready for upgrade** when you have resolved all validation errors.

**About purchase order upgrade**

When you invoice in Microsoft Dynamics AX 2012, the accounting framework does not relieve any accounting entries for accruals that were generated in an earlier version of the program. To upgrade to Microsoft Dynamics AX 2012, you must first relieve any accrual entries that remain for purchase order quantities received but not yet matched to vendor invoices.

To begin the upgrade, select the journal name. The journal name identifies the journal that make up the relief of accruals for purchase order quantities received but not yet matched to vendor invoices.

**Note:**
Set these parameters in Microsoft Dynamics AX 2009 to ensure that accounting entries are generated. The accounting entries are generated for the accrual for purchase quantities received but not yet matched to vendor invoices:
- Set the Post packing slip to ledger field to True in the Accounts payable parameters form.
- Set the Post accrued expense field to True in the item’s item model group.

**User relations upgrade - invalid company users**

Users can be internal or external. Internal users include employees, and external users include vendors, customers, and prospects. After you specify user relations, a user’s information, such as the employee ID or customer account ID, is automatically displayed in fields when that user opens a page in Enterprise Portal for Microsoft Dynamics AX. For external relations, data in the self-service portal for vendors is trimmed according to the user’s designated account. For example, if a user has an external relation for vendor account 1003, the user sees data only for that account in the self-service portal for vendors.

Use the following procedure to delete user accounts for a company when the user ID is not valid.

**Delete records when a user account has an invalid ID**

1. Click User relations upgrade – invalid company users.
2. Click Delete all.
3. Click Set to ready for upgrade.

**User relations upgrade missing contact person**

Users can be internal, such as employees, or external, such as vendors, customers, or prospects. After you specify user relations, a user’s information (such as employee ID or customer account ID) is automatically displayed in fields when that user opens an Enterprise Portal page. For external relations, data is trimmed on the vendor self-service portal according to account access. For example, if a user has an external relation for vendor account 1003, the user only sees data for that account in the vendor self-service portal.

Use this form to resolve issues when a user relation is not assigned a contact representative in your business or organization.

**Specify a contact for a user relation**

1. Click User relations upgrade missing.
2. Select a user in the list and then click User relations.
3. Click the General tab.
4. Use the Contact person drop-down list to select a contact representative in your business or organization.

**User relations upgrade duplicate user IDs**

Users can be internal, such as employees, or external, such as vendors, customers, or prospects. After you specify user relations, a user’s information (such as employee ID or customer account ID) is displayed automatically in fields when that user opens an Enterprise Portal page. For external relations, data is trimmed on the vendor self-service portal, according to account access. For example, if a user has an external relation for vendor account 1003, the user sees data for only that account in the vendor self-service portal.

Use this form to resolve conflicts when multiple user relations are mapped to a single Microsoft Dynamics AX user account. When each user relation has been assigned a unique Microsoft Dynamics AX user account, click Set to ready for upgrade.
Select which employee number to upgrade

If you used virtual companies in Microsoft Dynamics AX 2009, you might have two or more employee records that are associated with the same Address book ID (partyId). Microsoft Dynamics AX 2012 does not support having employee records that share the same Address book ID (partyId). Before you upgrade to Microsoft Dynamics AX 2012, for each set of employee records that share the same Address book ID (partyId), you must select one of the employee records to upgrade.

Select which employee records to upgrade

1. In the Preprocessing upgrade checklist, expand the Prepare application data for preprocessing node and then select Select which employee number to upgrade.
2. In the Select which employee number to upgrade form, a list of employee records is displayed. This list contains sets of records that share the same Address book ID (partyId). To indicate which records should be upgraded, select the Selected check box for only one record in each set of records that share the same Address book ID (partyId).
3. Click View related data loss to open the Data loss for discarded EmplIds form, where you can view the data associated with the records that you did not select in step 2. This data will not be upgraded.
4. Click Close to return to the Select which employee number to upgrade form.
5. Click Ready for upgrade.

Preprocess data on the live system

This section of the Preprocessing upgrade checklist contains data preprocessing tasks that can be carried out on a live system. While these tasks are being performed, your business operations can continue without interruption. The following sections are included.

- Run live preprocessing scripts
- Country/region upgrade
- Party upgrade
- Run delta preprocessing scripts

Run live preprocessing scripts

The Run live preprocessing scripts task opens the Upgrade live preprocessing form and displays the scripts that will write prepared data into the shadow and dictionary tables that were created by the Initialize preprocessing task. After you run the live preprocessing scripts, you must correct any issues that are flagged with an error status in the grid. After you correct an issue, you must rerun the failed script, or all failed scripts, until all live preprocessing scripts finish without error. You cannot proceed to running the single-user mode preprocessing scripts until you resolve all live preprocessing script errors.

Run the live preprocessing scripts

Depending on the amount of data you are processing, running the live preprocessing scripts may take a long time. The scripts run while your Microsoft Dynamics AX source system is live and being used for production. This can slow system performance. To lessen the impact of preprocessing on your live system, you can pause some or all of the scripts during business hours and resume them after business hours.
Complete the following steps to begin running the live preprocessing scripts.

1. In the **Preprocessing upgrade checklist**, click **Run live preprocessing scripts**.
2. In the **Upgrade live preprocessing** form, click **Run**.

### Pause and resume live preprocessing scripts

Complete the following steps to pause live preprocessing scripts.

1. In the **Upgrade live preprocessing** form, click **Manage running tasks**.
2. In the **Manage running tasks** form, do one of the following:
   - To pause a single script, select the script in the grid, and then click **Pause task**.
   - To pause all scripts, click **Pause all tasks**.

Complete the following steps to resume a paused script.

1. In the **Upgrade live preprocessing** form, click **Manage running tasks**.
2. In the **Manage running tasks** form, select a paused script in the grid, and then click **Resume task**.

### Country/region upgrade

Earlier in the process, you used the **Default country/region** form to specify for a company the default country/region to assign to address records that do not already have a specified country/region. For example, you selected a default country/region for Fabrikam, and that country/region will be assigned to any Fabrikam customer that does not already have a country/region selected for their address record. But Fabrikam has customers in multiple countries/regions, and the default country/region will not apply to all customers.

Use this form to change the country/region for individual addresses.

1. Click **Country/region upgrade** to open the **Addresses with no country/region** form. The form contains a list of addresses that do not have a country/region assigned.
2. Do one of the following:
   - To apply the same country/region to all the addresses in the list, select a country/region in the **Select a default country/region to apply** field, and then click **Apply**. You can filter the list and then apply a default country/region to the records that are displayed.
   - To set country/regions for addresses individually, select the address and then select a country/region in the **Country/region** field.
3. Update other address information as necessary.
4. Click the **Set to ready for upgrade** button.

### Party upgrade

A party is a person or organization that can be internal or external to your organization. Each party has its own record within Microsoft Dynamics AX. In Microsoft Dynamics AX 2012, every customer, vendor, prospect, and competitor must be categorized as either a person or an organization. When you are
upgrading to Microsoft Dynamics AX 2012, all customer, vendor, prospect, and competitor records are assigned the party type **Organization** by default.

Use this form to indicate any customers, vendors, prospects, and competitors that should be categorized as a **Person** party type and to verify the name components for each **Person** party record. You can also use this form to specify the name sequence, for example, First, Middle, Last, that will be used on a **Person** party record. **Person** party records also include contacts and employees.

1. Click **Party Upgrade** to open the **Party upgrade** form.
2. In the **Select the default person name sequence** field, select the sequence in which you want names to be displayed for a **Person** party record.
3. In the **Type** field, update any party records whose record type is changing from **Organization** to **Person**.
4. After you have updated all your party records, click **Set to ready for upgrade**.

### Run delta preprocessing scripts

You run the delta preprocessing scripts after you complete the **Global address book country/region upgrade** task on the Microsoft Dynamics AX source system. The delta preprocessing scripts check for changes to the production data that have occurred since you started running the live preprocessing scripts. Then, like the live preprocessing scripts, the delta scripts process the updated data into the shadow and dictionary tables.

Like the live preprocessing scripts, the delta preprocessing scripts run while your Microsoft Dynamics AX source system is live and being used for production. To optimize performance, you can pause some or all of the delta scripts by using the **Manage running tasks** form.

**Note:**

Some delta preprocessing scripts cannot be paused. These scripts appear in the grid with a **Task state** that says **The task does not support pausing**.

You can run the delta preprocessing scripts multiple times until you are ready to enter single-user mode. To minimize downtime, make sure to run the delta preprocessing scripts just before entering single-user mode.

### Run the delta preprocessing scripts

1. In the **Preprocessing upgrade checklist**, click **Run delta preprocessing scripts**.
2. In the **Upgrade delta preprocessing** form, click **Run**.

### Pause and resume the delta preprocessing scripts

Complete the following steps to pause delta preprocessing scripts.

1. In the **Upgrade delta preprocessing** form, click **Manage running tasks**.
2. In the **Manage running tasks** form, do one of the following:
   - To pause a single script, select a running script from the grid, and then click **Pause task**.
   - To pause all running scripts, click **Pause all tasks**.

Complete the following steps to resume a paused script.

1. In the **Upgrade live preprocessing** form, click **Manage running tasks**.
2. In the **Manage running tasks** form, select a paused script from the grid, and then click **Resume task**.
Preprocess data in single-user mode

This section of the Preprocessing upgrade checklist contains data preprocessing tasks that must be performed in single-user mode. Your system is offline for non-administrative users from now until the end of the upgrade process. The following topics are included.

- Enter into single-user mode
- Run single-user mode preprocessing scripts

Enter into single-user mode

You enter into single-user mode on the Microsoft Dynamics AX source system to make sure that the system is unavailable for business use. In single-user mode, only an upgrade user who has administrative permissions is connected. No other users can start a client session when the source system is in final preprocessing and source data is being bulk copied to the Microsoft Dynamics AX 2012 target system. After you enter into single-user mode, you can run the single-user mode preprocessing scripts and begin bulk copy of data to the target system.

In this step, you will do the following:

- Enter into single-user mode and end current user sessions by using the Online users form.
- Reopen client sessions for an administrative user on a single instance of the AOS (Microsoft Dynamics AX 4.0 only).
- Back up the source system database.
- Set the Microsoft SQL Server database recovery model to simple.

Enter single-user mode and end current user sessions

To enter single-user mode

1. In the Preprocessing upgrade checklist, click Enter into single-user mode.
2. Click Administration > Forms > Online users.
3. Click the Server Instances tab to see a list of all instances of the AOS that are running.
4. Select a server instance, click Reject new clients, and then click OK to confirm that you want to stop the AOS from accepting new client sessions.
   In the Status column, the status changes to Draining. This status means that no users can start a new client session in the AOS instance. However, rejecting new clients does not end any current sessions.
5. Repeat step four for all server instances that are running.

After you set the AOS instances to reject new client sessions, end all current client sessions. Before you do, make sure that all users who have active client sessions have finished their work.

To end client sessions

1. In the Online users form, click the Client Sessions tab.
2. Select the user sessions that you want to end (other than a single administrative user session), and then click End sessions.
3. In the End sessions window, click OK, and then click Close.

Reopen client sessions to set up batch threads in Microsoft Dynamics AX 4.0

The client-based batch framework in Microsoft Dynamics AX 4.0 supports only a single batch thread for each active client session. If you are upgrading from Microsoft Dynamics AX 4.0, you can open up to eight
user sessions to allow multiple batch threads. These batch threads are necessary for running the final preprocessing scripts and bulk copying data to the target system. All user sessions must be opened by an upgrade user who has administrative permissions. Open these client sessions on a single AOS instance.

To allow new client sessions
1. In the Online users form, click the Server instances tab.
2. Select a server instance, and then click Accept new clients.
   After you begin running the preprocessing upgrade scripts in the next checklist task, Run single-user mode preprocessing scripts, you can open the new client sessions for batch threads on Microsoft Dynamics AX 4.0. If you open additional sessions before starting the script run, the run will fail.
3. After you have opened the client sessions that you need for batch threads, return to the Online users form and click Reject new clients to prevent additional sessions from being opened.

Warning:
If you allow reopening client sessions in Microsoft Dynamics AX 4.0, you must take steps to ensure that no other users log on to make transactions when preprocessing scripts are being run and bulk copy is in progress. If any transactions are made on the Microsoft Dynamics AX source system during this time, your data will be invalid and the upgrade will fail.

Back up the source system database
Back up the source system SQL Server database to protect your data from any loss that may be caused by unexpected issues during single-user mode preprocessing. The backup also sets the initial recovery point for the simple recovery model that you will set for your SQL Server database during this stage of upgrade. To find the procedures for backing up your SQL Server database, use the following links:
- To back up a SQL Server 2008 database, see How to: Back Up a Database (SQL Server Management Studio)
- To back up a SQL Server 2005 database, see How to: Back Up a Database (SQL Server Management Studio)

Set the Microsoft SQL Server recovery model to simple
Before you begin final preprocessing on the source system, set the source system SQL Server recovery model to simple. By setting the recovery model to simple, you permit the high-performance bulk copy process that is optimal for running the single-user mode preprocessing scripts and bulk copy of the source data to the target system.
1. Open Microsoft SQL Server Management Studio (Start > All Programs > Microsoft SQL Server [version] > SQL Server Management Studio).
2. In Object explorer, select the database to open the Database properties - <database name> form.
3. In the Select a page pane, click Options.
4. In the Recovery model list, select Simple.
5. Click OK.

Run single-user mode preprocessing scripts
Run single-user mode preprocessing scripts is the final task in the Preprocessing upgrade checklist. This task first checks that the system is running with only a single administrative user logged in. If this test is successful, the Upgrade single-user preprocessing form opens. Clicking Run on this form launches
the delta upgrade scripts for a final time and then launches the upgrade scripts that prepare data to be bulk copied to the target system. These scripts run using set-based operation.

**Use parallel processing to reduce downtime**

Single-user mode operation of your Microsoft Dynamics AX system means that the system is unavailable for business transactions. The upgrade framework enables parallel processing of the source system data in order to keep downtime to a minimum. If you are upgrading from Microsoft Dynamics AX 2009, this checklist task will initiate parallel processing of the data automatically. If you are upgrading from Microsoft Dynamics AX 4.0, you can manually initiate parallel processing.

When you run single-user mode preprocessing on a Microsoft Dynamics AX 4.0 system, each client connection enables a single batch thread to run. To run multiple batch threads and improve performance, you allow the system to accept new connections, and then open multiple clients using the administrative login. While the system is accepting new connections, you must insure that no non-administrative users connect and make transactions. Any transaction made after you enter single-user mode will invalidate the data and the upgrade will fail. Also, if the source system uses multiple instances of the application object server (AOS), you must make sure that only one instance of the AOS allows new connections.

For more information, see [Enter into single-user mode](#).

**Prepare for single-user mode preprocessing**

Before you run the single-user mode preprocessing scripts, back up the Microsoft SQL Server database and set the database recovery model to *simple*. For more information about how to prepare for running the single-user mode preprocessing scripts, see [Enter into single-user mode](#).

Single-user mode preprocessing scripts on the source system run concurrently with the bulk copy of data to the Microsoft Dynamics AX 2012 target system, synchronization of the Microsoft SQL Server database on the source system, and post-synchronization of the database. This process will take several hours.

**Run the single-user mode preprocessing scripts**

Complete the following steps to run the single-user mode preprocessing scripts and complete the tasks on the *Preprocessing upgrade checklist*.

1. In the *Preprocessing upgrade checklist*, click *Run single-user mode preprocessing scripts*.
2. In the *Upgrade single-user preprocessing* form, click *Run* to start running the single-user mode preprocessing scripts.

**Additional upgrade preprocessing tasks**

This section contains topics describing additional upgrade tasks on your Microsoft Dynamics AX source system. Depending on your Microsoft Dynamics AX setup and your upgrade planning, these tasks may be optional or required after completion of the standard tasks in the *Upgrade preprocessing checklist*.

- [About Lean manufacturing migration](#)
- [About multisite activation readiness](#)
- [Using the preprocessing upgrade state transfer tool](#)
About Lean manufacturing migration

This topic describes the migration scenario for Microsoft Dynamics AX 2012 Lean manufacturing. There is a new data model, so there is no code upgrade needed. However, before you upgrade to Microsoft Dynamics AX 2012, you must migrate the Lean manufacturing for Microsoft Dynamics AX 2009 data to the new model. This scenario requires that you complete the following pre-upgrade tasks:

1. Create the Microsoft Dynamics AX 2012 Lean manufacturing framework and set up the necessary base data.
2. Prepare the current version data for migration to the Microsoft Dynamics AX 2012 Lean manufacturing framework.

You perform these tasks in the following forms:

- **Convert kanbans to next version kanban rules** form – Use this form to convert the current version kanban rules to the next version. To open the form, click **Preprocessing upgrade checklist** > **Prepare application data for preprocessing** > **Prepare kanbans for migration**. See [Convert kanbans to next version kanban rules](#) for more information.

- **Convert LOS-BTO schedules to next version kanban rules** form – Use this form to convert the current version LOS schedules to the next version. To open the form, click **Preprocessing upgrade checklist** > **Prepare application data for preprocessing** > **Prepare LOS schedules for migration**. See [Convert LOS-BTO schedules to next version kanban rules](#) for more information.

Create the Lean manufacturing framework

The Microsoft Dynamics AX 2012 Lean manufacturing data structures consist of production flows and production flow activities. To create these and set up the associated data, complete the following tasks. In the **Convert kanbans to next version kanban rules** form, or alternatively, in the **Convert LOS-BTO schedules to next version kanban rules** form, click **Next version base data**, and then select the appropriate form.

- In the **Production flow model** form, create and configure production flow models. These models define: the capacity settings for work cells and the display settings that are used in the kanban boards. See [Production flow model upgrade](#) for more information.

- In the **Lean manufacturing next version value streams** form, define the value streams that are used to classify and aggregate lean financial transactions. Each new production flow references a value stream. During the upgrade process, the value streams are converted to operating units. See [Lean manufacturing next version value streams](#) for more information.

- In the **Standard workdays for calendar** form, define the length of a standard work day, in hours, for the current calendars. To measure work cell capacity in periods that consist of hours and minutes, you must define this in the calendars. See [Standard work days for calendar](#) for more information.

- In the **Work cells migration** form, define additional settings for current work cells that are to be upgraded. The additional, mandatory settings to define are as follows: input warehouse and location, output warehouse and location, and production flow model. See [Work cells migration](#) for more information.

- In the **Production flows** form, create production flows and production flow activities that identify and describe your company’s basic business processes and product families. You can define process activities and you can define transfer activities. Create activity relations to link activities and establish a production flow sequence. See [Production flows upgrade](#) for more information.

- In the **Lean manufacturing next version parameters** form, define the additional production parameters for Lean manufacturing. These parameters are used to create production flows and
generate kanban jobs during the upgrade process. See Lean manufacturing next version parameters (form) for more information.

- In the Lean schedule groups form, define the lean schedule groups that are used to aggregate items for production at a particular work cell. See Lean schedule groups upgrade (form) for more information.

Prepare the current version data for migration

When the Microsoft Dynamics AX 2012 Lean manufacturing framework is created and the base data is set up, you prepare the current version data for migration to the next version. Use the Convert kanbans to next version kanban rules form to prepare the current version kanban rules. Alternatively, use the Convert LOS-BTO schedules to next version kanban rules form to prepare the current version LOS-BTO schedules.

Review the current rules and map them to the Microsoft Dynamics AX 2012 Lean manufacturing framework. The following table gives an overview of the core concepts in Lean manufacturing for Microsoft Dynamics AX 2009 and the corresponding concepts in Microsoft Dynamics AX 2012 Lean manufacturing. Use this information to guide you when you map the current kanban rules.

<table>
<thead>
<tr>
<th>Microsoft Dynamics AX 2009 feature</th>
<th>Microsoft Dynamics AX 2012 feature</th>
<th>Conversion of business rules</th>
<th>Conversion of active transactions</th>
<th>Conversion of handling units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed quantity kanban</td>
<td>Fixed quantity kanban</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Subcontracting kanban</td>
<td>Fixed or scheduled kanban</td>
<td>Convert to manufacturing kanban</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Purchase kanban</td>
<td>Withdrawal kanban from a warehouse location that has the item coverage type, Purchase order</td>
<td>Convert to withdrawal kanban</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>• PTO (pull-to-order) kanban</td>
<td>• Event kanban</td>
<td>Supported</td>
<td>Supported</td>
<td>Not applicable</td>
</tr>
<tr>
<td>• Sales</td>
<td>• Sales event</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Kanban</td>
<td>• Kanban line</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Target kanban</td>
<td>Scheduled kanban</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Phased target kanban</td>
<td>Scheduled kanban</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Family grouping and item grouping</td>
<td>Item allocation key</td>
<td>Supported</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Family grouping and item grouping</td>
<td>Lean schedule group</td>
<td>Supported</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Kanban group code</td>
<td>Kanban card number sequence</td>
<td>Supported</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Kanban template</td>
<td>All kanban types</td>
<td>Through item allocation key</td>
<td>As kanban type</td>
<td>As kanban type</td>
</tr>
<tr>
<td>Generic kanban</td>
<td>Not applicable. Use the Product configurator for configurable items.</td>
<td>Upgraded as a normal kanban rule without extended data.</td>
<td>Kanban is upgraded as normal fixed quantity kanban.</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>
About multisite activation readiness

The upgrade readiness check performs a series of configuration analysis tests to identify issues that could potentially affect data upgrade. These checks include verification that the multisite configuration is setup correctly. This includes verifying that the site and warehouse hierarchies are specified.

Important:
The upgrade readiness tests will not complete until the site structure is configured.

The following tables list and describe the conditions and requirements for multisite activation that the readiness check tests for. These tests ensure that the activation process is completed without errors.

<table>
<thead>
<tr>
<th>Description</th>
<th>Conditions</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site and warehouse relations</td>
<td>None</td>
<td>A site is assigned to all warehouses.</td>
</tr>
<tr>
<td>Site and warehouse relations</td>
<td>None</td>
<td>Warehouses only refer to quarantine warehouses that are located on the same site.</td>
</tr>
<tr>
<td>Site and work center relations</td>
<td>None</td>
<td>All work centers are linked to a site.</td>
</tr>
<tr>
<td>Site and production unit relations</td>
<td>None</td>
<td>All production units are linked to a site.</td>
</tr>
<tr>
<td>Site and production unit relations</td>
<td>None</td>
<td>Production units only refer to picking warehouses or storage warehouses that are located at the same site.</td>
</tr>
<tr>
<td>Site and production unit relations</td>
<td>None</td>
<td>All work centers that are associated with a production unit are linked to the same site as the production unit.</td>
</tr>
<tr>
<td>Physical inventory dimension group setup</td>
<td>More than one site is defined.</td>
<td>For each item that uses this dimension group, all transactions are related to the same site. Otherwise, some sites may have with negative inventory values.</td>
</tr>
<tr>
<td></td>
<td>An inventory dimension group exists where the warehouse dimension is not set to Physical inventory.</td>
<td></td>
</tr>
</tbody>
</table>

Note:
During the bulk upgrade process, the Microsoft Dynamics AX 2012 Lean manufacturing kanban rules are generated.
| Financial inventory dimension group setup | • More than one site is defined.  
• An inventory dimension group exists where the warehouse dimension is not set to Financial inventory. | For each item that uses this dimension group, all transactions are related to the same site. Otherwise, the cost may change. |
| Deleted warehouses | None | Activation will not result in cross-site markings.  
Closed inventory transactions do not refer to a warehouse that has been deleted. **InventDim** records cannot refer to a deleted warehouse. |
| Inventory dimensions in virtual companies | One or more virtual companies exist. | Tables that contain **InventDimId** fields are not shared across companies. |
| Intercompany configuration | Intercompany endpoints are defined. | For all intercompany action policies, the value mapping of the handling warehouse that is defined in the document configuration is set to not specified. |
| Site and task group relations | None | All work centers in a task group belong to the same site. This site must be the same site that is defined on the task group. |
| Site and task group relations | None | All task groups are assigned only to work centers located on the same site. |
| Site and bill of materials relations | None | All warehouses that are defined in the bill of materials are associated with the same site. Master planning assumes 0 (zero) days for picking. |
| Site and bill of materials relations | None | If a site is defined in the BOM version, all warehouses that are defined in the BOM belong to that same site. |
| Site and route relations | None | All work centers that are defined in a route belong to the same site. |
Site and route relations  | None  | A task group that is assigned to a route contains only work centers that are assigned to the same site as the work centers that are defined in the route.

Site and route relations  | None  | All work centers that are defined in a route version belong to the same site.

Site and route relations  | None  | For each route version that is assigned to a site, all work centers that are defined in the route belong to the same site.

Shipments setup  | A warehouse is not defined on the shipment  | Multisite cannot be activated. You must either complete or cancel the shipment before you upgrade.

Shipments template setup  | A warehouse is not defined on the shipment template  | Multisite cannot be activated. You must add a warehouse to the shipment template before you upgrade.

Fallback warehouse  | None  | A fallback warehouse is selected on the Other tab in the Company Information form.

Inventory dimensions  | None  | Inventory dimension combinations do not include both the site dimension and the warehouse dimension.

**Note:**
This check will fail when there is a defect in the application. To recover, you must manually clean up the Inventory Dimension table.

### Additional readiness checks
The following table describes additional readiness checks that the validation performs.

<table>
<thead>
<tr>
<th>Description</th>
<th>Conditions</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site and production order relations</td>
<td>None</td>
<td>Open production orders do not span multiple sites.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If this check fails, the validation displays a list of the production orders that span multiple sites.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You must end these production orders before upgrading.</td>
</tr>
<tr>
<td>Empty intercompany inventory dimensions</td>
<td>None</td>
<td>The intercompany inventory dimensions table is empty. This table is used only for temporary storage of data.</td>
</tr>
<tr>
<td>Empty intercompany inventory summary</td>
<td>None</td>
<td>The intercompany on-hand inventory table is empty. This table is used only to store data temporarily.</td>
</tr>
<tr>
<td>Empty quarantine orders</td>
<td>None</td>
<td>All quarantine orders are associated with a warehouse.</td>
</tr>
</tbody>
</table>
Using the preprocessing upgrade state transfer tool

The preprocessing upgrade state transfer tool helps you minimize downtime during upgrade. The tool also helps you avoid putting an additional load on your production Microsoft Dynamics AX system while you prepare to upgrade it. This topic describes how to create a test system that is a replica of your production system, perform data preprocessing on the test system, and then transfer the completed preprocessing state back to the production system.

How the state transfer tool works

The state transfer tool operates on a Microsoft Dynamics AX source system where some of the tasks of the Preprocessing upgrade checklist have been completed. The tool analyzes the code in the upgrade preprocessing project to identify the upgrade staging and framework tables that are required to capture the state of the Preprocessing upgrade checklist. The tool then uses the Microsoft SQL Server Bulk Copy Program (BCP) utility to copy these tables to a second Microsoft Dynamics AX source system. During bulk copy, you can add processor threads to improve data throughput.

Plan before you use the state transfer tool

The state transfer tool is intended to help minimize the amount of upgrade preprocessing that must be performed on a production system. Use the state transfer tool if you want to offload the live upgrade preprocessing task to a test server. However, note that use of this tool requires careful consideration and planning. We recommend that you test the tool on a non-production system before you use it for...
upgrade in your production environment. Also, after you perform a state transfer, you must reconcile the updated data in your test system with the data in your production system.

**Prepare to perform a state transfer**

Before you perform a state transfer, you must complete the following tasks on the test and production source systems.

**Prepare the production system**

1. On the production system, import the preprocessing XPO that is appropriate for the Microsoft Dynamics AX version that you are upgrading. For more information, see the [Microsoft Dynamics AX 2012 Upgrade Guide](#).
2. On the production system, install the upgrade-related label file (.ald) files. Also install the upgrade-related Help files (.chm) files. For more information, see the [Microsoft Dynamics AX 2012 Upgrade Guide](#).
3. On the Preprocessing upgrade checklist, complete the **Check upgrade readiness** task and resolve any validation errors. Enable triggers to track necessary data, based on prompts from the upgrade readiness checks. For more information about this step, see **Check upgrade readiness**.
4. The test system must be an exact replica of the production system. Copy the USR layer (.aod) file on the production system, and back up the production system database:
   a. Copy the USR layer (.aod) file. Typically, this file is located at C:\Program Files (x86)\Microsoft Dynamics AX\40\Application\<application instance>\axusr.aod or C:\Program Files\Microsoft Dynamics AX\50\Application\<application instance>\axusr.aod. Have this file available for installation on the test system.
   b. Use Microsoft SQL Server Management Studio to back up the Microsoft Dynamics AX database. Have this backup file available for installation on the test system.

   ✨ **Important:**
   After you copy the USR layer and make backup of the database, you must avoid making changes to the application on your production system. Data transactions may continue (allowing continued business operations), but metadata changes, customizations, changes to the AOT, and anything that changes the behavior of the application can cause the state transfer to fail.

**Prepare the test system**

The following steps produce a test source system that is configured identically to the production source system.

⚠️ **Warning:**
Do not import the upgrade XPO into the test source system. The necessary upgrade framework code is provided in the AOD file that you copied from the production source system. Importing the XPO overwrites element IDs and causes runtime errors.

1. Install the upgrade-related label files (.ald) files. Also install the upgrade-related Help (.chm) files. For more information, see the [Microsoft Dynamics AX 2012 Upgrade Guide](#).
2. Install the USR layer (.aod) file that you copied from the production system. Typically, this file is installed at C:\Program Files (x86)\Microsoft Dynamics AX\40\Application\App\Standard\axusr.aod or C:\Program Files\Microsoft Dynamics AX\50\Application\App\DynamicsAX5\axusr.aod.
3. Use SQL Server Management Studio to restore the database backup from the production system as the Microsoft Dynamics AX database on the test system.
Important:
After you complete these steps, you must restart Application Object Server (AOS).

The test source system is now ready for upgrade preprocessing. We recommend that you complete the following tasks on the Preprocessing upgrade checklist:
1. All tasks in the Prepare application data for preprocessing section
2. Run live preprocessing scripts
3. Run delta preprocessing scripts

Enable the database connection
Windows integrated security is used to connect to the production source system from the test source system. The administrative user who is performing the state transfer must have access to the Microsoft Dynamics AX database on the production source system. Otherwise, the production source system rejects the database connection. Open SQL Server Management Studio on the production source system, and follow these steps:
1. Grant access to the Microsoft Dynamics AX database to a domain user who has administrative privileges on the test source system.
2. Add this user to the db_owner and public database roles.

Open the Preprocessing upgrade state transfer form
After you have completed upgrade preprocessing on the test system, open the Preprocessing upgrade state transfer form on the production system. The form is opened from a private project that is installed by the preprocessing framework XPO.
1. Click the Project icon on the Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 toolbar.
2. Expand Private.
3. Double-click xferUpgState (usr).
4. Scroll down to xferUpgState (usr), right-click, and then click Open.

Perform the state transfer
1. In the Server name field, enter the name of the test system.
2. In the Database name field, enter the name of the Microsoft Dynamics AX database for the test system.
3. Click Run to start the upgrade state transfer. The state transfer tool validates conditions in both the test system and the production system. If no errors are found, the tool schedules batch jobs to bulk copy all shadow, dictionary, auxiliary, and framework tables from the test source system to the production source system.

A form opens so that you can monitor and manage the bulk copy process. The form is called Batch list in Microsoft Dynamics AX 4.0 and Batch tasks in Microsoft Dynamics AX 2009. You can use the form to pause or rerun jobs if you have to.

Important:
To use the state transfer tool, you must enable administrative user access between the test and production systems by using Windows integrated security.
Perform post-transfer tasks

After the state transfer is complete, run open the **Preprocessing upgrade checklist** and rerun the tasks in the section **Prepare application data for preprocessing**. This will allow you to make manual adjustments to new data from the delta between production system backup and completion of the state transfer. Finally, run the delta preprocessing scripts, and then continue with upgrade preprocessing in single-user mode.
Create the target system

This section documents the installation and configuration of Microsoft Dynamics AX 2012 on a target computer system as part of upgrade. Installation on the target system is performed separately from procedures carried out on the source system, and may be done concurrently with data upgrade preprocessing. The following sections are included.

- Verify that you have the required permissions for installation
- Set permissions specific to upgrade
- Install Microsoft Dynamics AX (upgrade)
Verify that you have the required permissions for installation

Before beginning the Microsoft Dynamics AX installation process, work with a system administrator to ensure that the account you log on with at each server has appropriate permissions. The permissions listed below are implemented according to the principle of least privilege.

In all cases, you must be a member of the **Administrators** group on the local computer where you are installing a component. The following table lists permissions that are required in addition to administrator access on the computer.

<table>
<thead>
<tr>
<th>Component</th>
<th>Additional permissions required to install</th>
</tr>
</thead>
<tbody>
<tr>
<td>Databases</td>
<td>Member of the <strong>dbcreator</strong> role on the SQL Server instance. If you are installing the databases remotely from a computer other than the database server, you must log on to the remote computer with an account that is an administrator on the SQL Server computer. Setup requires access to SQL Server services.</td>
</tr>
<tr>
<td>Application Object Server (AOS)</td>
<td>Member of the <strong>securityadmin</strong> role on the SQL Server instance you want to connect to.</td>
</tr>
</tbody>
</table>
| Enterprise Portal                | • Member of the **System administrator** role in Microsoft Dynamics AX  
                                 | • Member of the **Administrators** group in Windows on the Web server  
                                 | • Member of the **Farm Administrators** group in Microsoft SharePoint 2010 products  
                                 | • Member of the **dbcreator** role on the SQL Server instance being used for SharePoint 2010 products  
                                 | • Member of the **WSS_Content_Application_Pools** database role in the SharePoint_Config database |
| Enterprise Search                | • Member of the **System administrator** role in Microsoft Dynamics AX  
                                 | • Member of the **Administrator** group in Microsoft SharePoint Services  
                                 | • Member of the **dbcreator** role on the SQL Server instance being used for Microsoft SharePoint Services |
| Help server                      | Member of the **System administrator** role in Microsoft Dynamics AX.                                        |
| Reporting Services extensions    | Member of the **System administrator** role in Microsoft Dynamics AX.                                        |
| Analysis Services configuration  | Member of the SQL Server **db_accessadmin** role for the Microsoft Dynamics AX database.                   |
| Client                           | None                                                                                                      |
| Office add-ins                   | None                                                                                                      |
| Remote Desktop Services integration | None                                                                                                    |
| Debugger                         | None                                                                                                      |
| Visual Studio Tools              | None                                                                                                      |
| Trace Parser                     | None                                                                                                      |
| Web services on IIS             | Member of the **System administrator** role in Microsoft Dynamics AX.                                        |
| .NET Business Connector          | None                                                                                                      |
| Synchronization proxy           | Member of the **dbowner** database role on the SQL Server database for Microsoft Project Server.          |
Set permissions specific to upgrade

Before you begin the Microsoft Dynamics AX installation process, work with a system administrator to ensure that the account you log on with at each server has the following permissions that are specific to upgrade. These permissions are implemented according to the principle of least privilege.

Set permissions

The following table lists permissions that must be set for upgrade.

<table>
<thead>
<tr>
<th>Component</th>
<th>Additional permissions required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade checklists</td>
<td>Member of the SYSADMIN role in Microsoft Dynamics AX.</td>
</tr>
<tr>
<td>Source database (the database that will be upgraded to Microsoft Dynamics AX 2012)</td>
<td>Same domain user (using Windows integrated security) must have ownership privileges on both the source Microsoft Dynamics AX and target Microsoft Dynamics AX 2012 databases.</td>
</tr>
</tbody>
</table>

Install Microsoft Dynamics AX (upgrade)

You must install Microsoft Dynamics AX 2012 on a new server computer before completing the upgrade from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009. For complete installation instructions, refer to the Microsoft Dynamics AX Installation Guide.

⚠️ Important:
Be sure to select Register database for upgrade as an option during installation.
Upgrade the target system

This section documents how to upgrade a newly installed Microsoft Dynamics AX target system. These procedures must be coordinated with those described in the section Preprocess data on the source system. The following sections are included.

- Perform code upgrade
- Perform data upgrade
- Upgrade Enterprise Portal
Perform code upgrade

A new Microsoft Dynamics AX 2012 system that is registered for upgrade displays the Select the appropriate upgrade checklist form on startup. This is unlike a new default installation, which displays the Initialization checklist on startup. Use the Select the appropriate upgrade checklist form to begin either code upgrade or data upgrade on your target system. If your source system contains customized application code, you must perform code upgrade on your target system in order to preserve your customizations. Code upgrade, if it is required, must be performed before data upgrade. The selector form will continue to appear on startup until the data upgrade tasks have been completed.

Tip:
If you have no custom code to upgrade, select Data upgrade checklist now in the Select the appropriate upgrade checklist form. For more information, see Perform data upgrade.

Select a code upgrade checklist

Microsoft Dynamics AX 2012 supports two code upgrade scenarios:

- You are upgrading code from a Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system that contains application code in AOD (.aod) files.
- You are upgrading from a version of Microsoft Dynamics AX that uses models instead of AOD files.

The Select the appropriate upgrade checklist form offers a code upgrade checklist that corresponds to each scenario:

- AOD code upgrade checklist
- Model code upgrade checklist

Select the correct option for your scenario and then click OK. The checklist that opens will guide you through the required tasks.

Additional information about code upgrade

For more information about how to upgrade code, see Microsoft Dynamics AX 2012 White Papers: Code Upgrade on the Microsoft Download Center.

Complete the code upgrade tasks

The rest of this section describes the tasks that you must complete to import and upgrade your customized code on the Microsoft Dynamics AX 2012 target system.

- Provide license information
- Import Microsoft AOD files into the baseline model store
- Import Microsoft-signed model files into baseline model store
- Import AOD files into the baseline model store
- Import AOD files into the new model store
- Import label files into the new model store
- Import layer model(s) into baseline model store
- Import layer model(s) into new model store
- Restart Application Object Server
- Compile the application (upgrade)
- Detect code upgrade conflicts
Provide license information

To be able to use Microsoft Dynamics AX, the administrator must enter license information. By entering license codes, you enable the general functionality covered by the license. Then, you can enable or disable access to more specific features by changing configuration keys.

Note:
If you change the current license settings because license keys are updated, the new functionality will not be available until the client is restarted.

In addition to license codes for Microsoft Dynamics AX functionality, there are licenses for access to the Microsoft Dynamics AX development environment. For more information, see the Developer Help, available from the Microsoft Dynamics AX Help menu.

If you do not have a license, you can set up Microsoft Dynamics AX in demonstration mode. Demonstration mode provides all the functionality of Microsoft Dynamics AX, and enables all configuration keys by default.

Language-specific licenses

If your license includes specific languages, you must restart the AOS after importing the license file or entering license information. Restarting the AOS ensures that the correct languages are listed in the Options form (Microsoft Dynamics AX > Tools > Options...).

If you do not restart the AOS, end users will be able select unlicensed languages, which would prevent the Microsoft Dynamics AX client from starting.

Import license information

1. License information
2. Click Load license file to import the license codes from a file.
   The Load license file dialog box appears.
3. Click the folder icon and browse for the license file.

Note:
We recommend that you store the license file in a secure location that is known only to Microsoft Dynamics AX administrators.

4. Click OK. A message appears, asking whether you want to synchronize the database.
5. Click Yes.
6. Close the License information window.

Enter license information

As an alternative to importing the license information, you can enter the license information manually.

1. License information
2. Enter the name of the license holder, the system's serial number, and the expiration date. The information is in the license document.
3. On the System tab, enter the license code and verify that the Status field displays the expected text. The license code indicates whether you have a standard, professional, or enterprise solution.
Important:
The first four entries (name of the license holder, the system’s serial number, expiration date, and license code) determine what appears in the remaining codes. Therefore, they must be entered correctly.

4. Enter the remaining codes. For each, review the Status field to make sure that the code is accepted.

### Import Microsoft AOD files into the baseline model store

Import Microsoft application files, or .aod files, from the source system into the baseline model store.

Use the following procedure to import .aod files into the baseline model store.

1. On the server, create a folder named Old in the following location: %ProgramFiles%\Microsoft Dynamics AX\60\Server\MicrosoftDynamicsAX\bin\Application\App\Standard.
2. Copy the Microsoft .aod files from the source system to the Old folder.
3. Some layers have been renamed in Microsoft Dynamics AX 2012. Rename each .aod file to the new name of the layer in Microsoft Dynamics AX 2012. The following table shows the names of the layers in different versions of Microsoft Dynamics AX.

<table>
<thead>
<tr>
<th>Microsoft Dynamics AX 4.0 layer</th>
<th>Microsoft Dynamics AX 2009 layer</th>
<th>Microsoft Dynamics AX 2012 layer (Rename to this)</th>
</tr>
</thead>
<tbody>
<tr>
<td>axbup.aod</td>
<td>axbup.aod</td>
<td>axisp.aod</td>
</tr>
<tr>
<td>axbus.aod</td>
<td>axbus.aod</td>
<td>axisv.aod</td>
</tr>
<tr>
<td>axlop.aod</td>
<td>axsl3.aod</td>
<td>axslp.aod</td>
</tr>
<tr>
<td>axlos.aod</td>
<td>axsl2.aod</td>
<td>axsln.aod</td>
</tr>
<tr>
<td>axdip.aod</td>
<td>axsl1.aod</td>
<td>axfpp.aod</td>
</tr>
<tr>
<td>axdis.aod</td>
<td>axhfx.aod</td>
<td>axfpk.aod</td>
</tr>
</tbody>
</table>

4. In the Import Microsoft AODs into the baseline model store dialog box, select the name of the layer file that you want to import. When you import layers, you must start with the lowest layer.

5. Click OK to import the .aod file.

If the .aod file contains items that cannot be imported, an Infolog message is displayed. For more information, see the log file referenced in the message. Usually, an application object cannot be imported for one of the following reasons:

- A method was added to a class that no longer exists in the Application Object Tree (AOT).
- There is an ID conflict between two elements that have the same name and type, but different IDs.
- You customized a hybrid class or a table that supports inheritance.

To resolve these issues, identify the application objects that were not imported from your Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system. Export all of these application objects to an .xpo file. Then import the .xpo file into the Microsoft Dynamics AX 2012 system by clicking Import on the AOT toolbar.

6. Continue with the next steps in the code upgrade checklist.

Important:
You must first import the layers that Microsoft owns. You can then import the remaining layers one at a time, starting with the lowest layer.
Import Microsoft-signed model files into baseline model store

Import the model files that are signed by Microsoft into the baseline model store by using the AxUtil command-line utility.

Use the following procedure to import Microsoft-signed model files into the baseline model store.

1. On the target system, import the Microsoft-signed model files that you received from Microsoft by using the AxUtil import command-line utility. For example, to import the Foundation model into the MicrosoftDynamicsAXBaseline model store, type the following command:

   AxUtil import /file:”Foundation.axmodel” /db:MicrosoftDynamicsAXBaseline

   For more information about the AxUtil import utility, see the help for AxUtil by typing “AxUtil /?.”

2. After you have imported all of the Microsoft-signed models, continue with the next steps in the code upgrade checklist.

   ! Important:
   You must import Microsoft-owned models before other models. Then import the remaining models one at a time, starting with the lowest layer.

Import AOD files into the baseline model store

Import the .aod file for the layer that you want to upgrade from the source system into the baseline model store.

Use the following procedure to import AOD files into the baseline model store.

1. On the server, create a folder that is named Old in the following location:

   %ProgramFiles%\Microsoft Dynamics AX\60\Server\MicrosoftDynamicsAX\bin\Application\App\Standard

2. Copy the .aod file for the current layer from the source system to the Old folder.

3. Some layers have been renamed in Microsoft Dynamics AX 2012. Rename each .aod file to the new name of the layer in Microsoft Dynamics AX 2012. The following table shows the names of the layers in different versions of Microsoft Dynamics AX.

<table>
<thead>
<tr>
<th>Microsoft Dynamics AX 4.0 layer</th>
<th>Microsoft Dynamics AX 2009 layer</th>
<th>Microsoft Dynamics AX 2012 layer (Rename to this)</th>
</tr>
</thead>
<tbody>
<tr>
<td>axbup.aod</td>
<td>axbup.aod</td>
<td>axisp.aod</td>
</tr>
<tr>
<td>axbus.aod</td>
<td>axbus.aod</td>
<td>axisv.aod</td>
</tr>
<tr>
<td>axlop.aod</td>
<td>axsl3.aod</td>
<td>axslp.aod</td>
</tr>
<tr>
<td>axlos.aod</td>
<td>axsl2.aod</td>
<td>axsln.aod</td>
</tr>
<tr>
<td>axdip.aod</td>
<td>axsl1.aod</td>
<td>axfpp.aod</td>
</tr>
<tr>
<td>axdis.aod</td>
<td>axhfx.aod</td>
<td>axfpk.aod</td>
</tr>
</tbody>
</table>

4. In the **Import layer AOD into the baseline model store** dialog box, select the name of the .aod file that you want to import. When you import layer files, you must start with the lowest layer.

5. Click OK to import the .aod file.

   If the .aod file contains items that cannot be imported, an **Infolog** message is displayed. For more information, see the log file referenced in the message. Usually, an application object cannot be imported because of one of the following reasons:

   - A method was added to a class that no longer exists in the Application Object Tree (AOT).
There is an ID conflict between two elements that have the same name and type, but different IDs.

You customized a hybrid class or a table that supports inheritance.

To resolve these issues, identify all the application objects that were not imported from your Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system. Export these application objects to an .xpo file. Then import the .xpo file into the Microsoft Dynamics AX 2012 system by clicking Import on the AOT toolbar.

6. In the code upgrade checklist, continue with the next steps for the layer file that you imported. Then return to this procedure when you are ready to import the next layer file.

Important:
You must import Microsoft-owned models before other models. Then import the remaining models one at a time, starting with the lowest layer.

Import AOD files into the new model store

Import the .aod file for the layer that you want to upgrade from the source system into the new model store.

Use the following procedure to import .aod files into the new model store.

1. Copy the .aod file for the current layer from the source system to the following folder:
   \%ProgramFiles\%\Microsoft Dynamics AX\60\Server\MicrosoftDynamicsAX\bin\Application\App\Standard

   Do not copy the .aod files for the layers that Microsoft owns into this folder.

2. Some layers have been renamed in Microsoft Dynamics AX 2012. Rename the .aod file to the new name of the layer in Microsoft Dynamics AX 2012. The following table shows the names of the layers in different versions of Microsoft Dynamics AX.

<table>
<thead>
<tr>
<th>Microsoft Dynamics AX 4.0 layer</th>
<th>Microsoft Dynamics AX 2009 layer</th>
<th>Microsoft Dynamics AX 2012 layer(Rename to this)</th>
</tr>
</thead>
<tbody>
<tr>
<td>axbup.aod</td>
<td>axbup.aod</td>
<td>axisp.aod</td>
</tr>
<tr>
<td>axbus.aod</td>
<td>axbus.aod</td>
<td>axisv.aod</td>
</tr>
<tr>
<td>axlop.aod</td>
<td>axsl3.aod</td>
<td>axslp.aod</td>
</tr>
<tr>
<td>axlos.aod</td>
<td>axsl2.aod</td>
<td>axsln.aod</td>
</tr>
<tr>
<td>axdip.aod</td>
<td>axsl1.aod</td>
<td>axfpp.aod</td>
</tr>
<tr>
<td>axdis.aod</td>
<td>axhfx.aod</td>
<td>axfpk.aod</td>
</tr>
</tbody>
</table>

3. In the Import layer AOD into the new model store dialog box, select the name of the .aod file that you want to import. When you import layer files, you must start with the lowest layer. However, do not import the layers that Microsoft owns into the new model store.

4. Select the model that you want to import the .aod file into.

5. Click OK to import the .aod file.

If the .aod file contains items that cannot be imported, An Infolog message is displayed. For more information, see the log file referenced in the message. Usually, an application object cannot be imported because of one of the following reasons:

- A method was added to a class that no longer exists in the Application Object Tree (AOT).
- There is an ID conflict between two elements that have the same name and type, but different IDs.
You customized a hybrid class or a table that supports inheritance.

To resolve these issues, identify all the application objects that were not imported from your Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 system. Export these application objects to an .xpo file. Then import this .xpo file into the Microsoft Dynamics AX 2012 system by clicking Import on the AOT toolbar.

6. In the code upgrade checklist, continue with the next steps for the layer file that you imported. Then return to this procedure when you are ready to import the layer file for the next layer. You can then import the remaining layers one at a time, starting with the lowest layer.

### Import label files into the new model store

Import custom label files, or .ald files, into the new model store.

Use the following procedure to import label files into the new model store.

1. On the Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009 source system, create a label file for the layer that you are importing by using the Label File Wizard. Then copy the label file to the Microsoft Dynamics AX 2012 system.
2. In the Select file dialog box, select the name of the label file that you want to import. You must select the label file that corresponds to the .aod file that you imported in the previous step of the code upgrade checklist.
3. Click OK to import the label file.
4. In the code upgrade checklist, continue with the next steps for the label file that you imported. Then return to this procedure when you are ready to import the next label file. You can then import the remaining layers one at a time, starting with the lowest layer.

### Import layer model(s) into baseline model store

Import all of the model files for a given layer into the baseline model store by using the AxUtil command-line utility.

Use the following procedure to import a layer model into the baseline model store.

1. On the source system, export all models for the current layer by using the axutil export command-line utility. For example, to export the USR model, type the following command:

   AxUtil export /model:"USR Model" /file:"UsrModel.axmodel"

   For more information about the AxUtil export utility, see the help for AxUtil. Type AxUtil /?.
2. On the target system, import all models from the previous step into the baseline model store by using the AxUtil import command-line utility. For example, to import the model from the previous step into the MicrosoftDynamicsAXBaseline model store, type the following command:

   AxUtil import /file:"UsrModel.axmodel" /db:MicrosoftDynamicsAXBaseline

   For more information about the AxUtil import utility, see the help for AxUtil. Type AxUtil /?.
3. After you have imported all models for the current layer, continue with the next steps in the code upgrade checklist. Then return to this step when you are ready to import the models for the next highest layer.

**Important:**

You must import Microsoft-owned models before other models. Then import the remaining models one at a time, starting with the lowest layer.
Import layer model(s) into new model store

For a given layer, import the files for the layer model into the new model store by using the AxUtil command-line utility.

Use the following procedure to import a layer model into the new model store.

1. On the source system, export all models for the current layer by using the AxUtil export command-line utility. For example, to export the USR model, type the following command:

   ```
   AxUtil export /model:"USR Model" /file:"UsrModel.axmodel"
   ```

   For more information about the AxUtil export utility, see the Help for AxUtil. Type AxUtil /?.

2. On the target system, import all models from the previous step into the new model store by using the AxUtil import command-line utility. For example, to import the model from the previous step into the MicrosoftDynamicsAX model store, type the following command:

   ```
   AxUtil import /file:"UsrModel.axmodel" /db:MicrosoftDynamicsAX
   ```

   For more information about the AxUtil import utility, see the Help for AxUtil. Type AxUtil /?.

3. After you have imported all models for the current layer, continue with the next steps in the Code upgrade checklist. Then, return to this step when you are ready to import the models for the next highest layer.

   ✅ Important:
   You must import Microsoft-owned models before other models. Then import the remaining models one at a time, starting with the lowest layer.

Restart Application Object Server

Restart the Application Object Server (AOS) when you have finished importing a layer.

Restart the AOS as follows during code upgrade:

1. When you have finished importing the layer, restart the Application Object Server (AOS).
2. When the AOS has restarted, continue with the next steps in the code upgrade checklist. Then, return to this step when you are ready to import the next highest layer.

Compile the application (upgrade)

When the Microsoft Dynamics AX application is compiled, its source code is translated into a machine-readable format that can be interpreted by the Microsoft Dynamics AX server and clients. You compile the application to ensure that all object references are updated and the application is ready to use.

This task is optional in the Data upgrade checklist. However, to prevent unexpected program behavior, we advise you to compile all of your code after code upgrade.

✅ Important:
Depending on your hardware, compilation can take an hour or more. It is critical to let compilation run until it is complete.
Detect code upgrade conflicts
Create an upgrade project that contains objects that have conflicts because of modifications or updates. The project contains objects that have been changed both in the new release and in your application object layer.

Creating an upgrade project
1. From the Microsoft Dynamics AX developer workspace, click **Tools > Code upgrade > Detect code upgrade conflicts**.
2. Select **Create layer conflict project**.
3. (Optional) To create separate projects for conflicting record IDs and table IDs, select **Create framework conflict project or projects**, and then select the **Record and table ID references** check boxes.
4. Click **OK**.
   One or more new upgrade projects are created.

Alternatives to the Detect code upgrade conflicts tool
Instead of using the **Detect code upgrade conflicts** tool, you can use the **Compare layers** tool to compare any two layers. You can also use the **Compare layers** tool to create a project that contains the objects that differ.

Note:
When you use the **Detect code upgrade conflicts** tool, you can delete duplicates. However, you cannot delete duplicates when you use the **Compare layers** tool. Therefore, the **Compare layers** tool may be more useful as a general tool, for example, to provide an overview of the modifications that were made in a certain layer.

During the upgrade, you can use the **Project filter** tool instead of both the **Detect code upgrade conflicts** tool and the **Compare layers** tool. You can use the **Project filter** tool to create a project that is based on criteria that you specify in a query form. For example, the project can contain all objects that are from a specific layer, all objects that have a specific prefix, or all objects that were created by a specific user.

Compile into .NET Framework CIL
The **Compile into .NET Framework CIL** task converts your compiled application code into Common Intermediate Language (CIL) code that can be consumed by the Microsoft .NET Framework.

The purpose of CIL
CIL is the bytecode language that the just-in-time (JIT) compiler of the .NET Framework interprets. Microsoft Dynamics AX converts compiled X++ code, or p-code, to CIL. This conversion provides interoperability with .NET classes, and it also improves performance. The following Microsoft Dynamics AX components rely on the speed of CIL:
- Batch jobs
- Application Integration Framework (AIF) and services
- Run-as scenarios, in which .NET functions are substituted for X++ functions at run time
Scenarios that require the CIL task

You may have to run the Compile into .NET Framework CIL task in the following two scenarios:

- You are installing Microsoft Dynamics AX, and you encounter the task in the Initialization checklist.
- You are performing an upgrade on a Microsoft Dynamics AX system that includes customized application code, and you encounter the task in either the AOD code upgrade checklist or the Model code upgrade checklist.

⚠️ Important:

In all checklists that include the Compile into .NET Framework CIL task, the previous task is Compile application. You must complete the Compile application task before you can perform the Compile into .NET Framework CIL task.

Perform data upgrade

Data upgrade on your Microsoft Dynamics AX target system completes the upgrade process. During data upgrade, preprocessed data from your source system will be bulk-copied to the target system and imported into the new Microsoft Dynamics AX database.

Open the Data upgrade checklist

The tasks that are involved in data upgrade are collected in the Data upgrade checklist. The checklist can be opened by clicking System administration > Setup > Checklists > Data upgrade checklist. Alternatively, you can select the Data upgrade checklist option in the Select the appropriate upgrade checklist form. This form opens automatically on any newly installed system where data upgrade has not been completed.

Complete the data upgrade tasks

The rest of this section describes the tasks that you must complete to import and upgrade your data on the target system.

- Provide license information
- Set customer feedback options
- Connect to source database
- Set current time zone
- Presynchronize (upgrade)
- Create tables
- Generate table mappings
- Generate upgrade task prioritization
- Launch data upgrade
- Post journal for relief of legacy accrual of unmatched quantities
- Configure system accounts
- Finalize Enterprise Portal upgrade
- Specify Role Center web site
- Assign a primary address to parties
- Upgrade services and AIF
- Compare data upgrade row counts
- Upgrade additional features
Provide license information

To be able to use Microsoft Dynamics AX, the administrator must enter license information. By entering license codes, you enable the general functionality covered by the license. Then, you can enable or disable access to more specific features by changing configuration keys.

**Note:**
If you change the current license settings because license keys are updated, the new functionality will not be available until the client is restarted.

In addition to license codes for Microsoft Dynamics AX functionality, there are licenses for access to the Microsoft Dynamics AX development environment. For more information, see the Developer Help, available from the Microsoft Dynamics AX Help menu.

If you do not have a license, you can set up Microsoft Dynamics AX in demonstration mode. Demonstration mode provides all the functionality of Microsoft Dynamics AX, and enables all configuration keys by default.

Language-specific licenses

If your license includes specific languages, you must restart the AOS after importing the license file or entering license information. Restarting the AOS ensures that the correct languages are listed in the **Options** form (Microsoft Dynamics AX > Tools > Options...).

If you do not restart the AOS, end users will be able select unlicensed languages, which would prevent the Microsoft Dynamics AX client from starting.

Import license information

1. **License information**
2. Click **Load license file** to import the license codes from a file.
   The **Load license file** dialog box appears.
3. Click the folder icon and browse for the license file.
   **Note:**
   We recommend that you store the license file in a secure location that is known only to Microsoft Dynamics AX administrators.
4. Click **OK**. A message appears, asking whether you want to synchronize the database.
5. Click **Yes**.
6. Close the **License information** window.

Enter license information

As an alternative to importing the license information, you can enter the license information manually.

1. **License information**
2. Enter the name of the license holder, the system's serial number, and the expiration date. The information is in the license document.
3. On the **System** tab, enter the license code and verify that the **Status** field displays the expected text. The license code indicates whether you have a standard, professional, or enterprise solution.
4. Enter the remaining codes.
   For each, review the Status field to make sure that the code is accepted.

Set customer feedback options
Open the Microsoft Dynamics AX customer feedback options form from the initialization the Data upgrade checklist.
Join the Customer Experience Improvement Program to help improve the quality, reliability, and performance of Microsoft software and services.
The program collects information about computer hardware and how you use Microsoft Dynamics AX, without interrupting you. This helps Microsoft identify which Microsoft Dynamics AX features to improve. No information collected is used to identify or contact you.
For more information and a complete privacy statement for the Customer Experience Improvement Program, visit the Customer Experience Improvement Program Web site.

Connect to source database
The Connect to source database task in the Data upgrade checklist establishes a connection between the Microsoft Dynamics AX source system database and the target system database. After you make this connection, you can begin preparing the target database for the bulk-copy operation that occurs during data upgrade.

Configure matching user permissions
Windows integrated security is used to connect to the source database from the target system. If the administrative user who is performing the upgrade on the target system does not have access to the source system database, the source system will reject the database connection. Open Microsoft SQL Server Management Studio on the source system and perform the following steps:
1. Grant Microsoft Dynamics AX database access to a domain user with administrative privileges on the target Microsoft Dynamics AX 2012 system.
2. Add the user to the db_owner and public roles.

Connect to source database
Complete the following steps:
1. In the Data upgrade checklist, expand the Data upgrade group.
2. Click Connect to source database.
3. In the Connect to source database form, do the following:
   a. In the Server name field, type the name of the server and the Microsoft SQL Server database in the format SERVER\DATABASE.

b. In the Database field, type the name of the Microsoft Dynamics AX source database instance, for example, DynamicsAX50.

4. Click OK.

The upgrade framework searches the network for the server and database that you specified. When the computers connect successfully, the Presynchronize task becomes available in the Data upgrade checklist.

Set current time zone

Before you upgrade your data from Microsoft Dynamics AX 4.0, you must specify your local time zone. This task opens the Current time zone form so that you can enter this information.

Important:
This checklist item applies only when you are upgrading from Microsoft Dynamics AX 4.0. The Data upgrade checklist will always display this task prior to communication between the source and target databases. At that point, the task disappears unless a Microsoft Dynamics AX 4.0 source system is detected.

The preferred method of storing date and time data in Microsoft Dynamics AX is Coordinated Universal Time (UTC), as specified by the utcDateTime data type. During data upgrade, both shipped and custom tables are scanned to identify system date and time fields. Your local time zone setting determines the offsets to apply to these fields when they are converted to UTC.

If custom date or time fields have been added to Microsoft Dynamics AX, you must decide whether those fields should be merged into new utcDateTime fields during upgrade. For more information, see Walkthrough: upgrading date and time table field pairs into UtcDateTime.

Presynchronize (upgrade)

When you perform the Presynchronize task in the target system, you use the Data upgrade cockpit (%1 -> %2) to run scripts that map the database schema on the source Microsoft Dynamics AX system to the database schema on the target system. This table-to-table and column-to-column mapping is new with Microsoft Dynamics AX 2012, and prepares the target database for synchronization. If like-to-like mapping fails and errors result, you can manually repair the mapping and rerun the script. Indexing is disabled while the presynchronization scripts are running.

The presynchronization scripts that ship with Microsoft Dynamics AX 2012 are meant to serve as models for developers of new Microsoft Dynamics AX modules.

Prepare your database for synchronization as follows:

1. In the Data upgrade checklist, click Presynchronize. The Data upgrade cockpit (%1 -> %2) opens and lists the upgrade tasks to be completed.
2. Click Run. In the Upgrade job grid, an icon next to each job indicates the job’s status as the presynchronization scripts run.
3. Address any errors that occur and then rerun the scripts.

Create tables

You perform the Create tables task to prepare the Microsoft Dynamics AX 2012 target database for upgrade. During this step, the Microsoft Dynamics AX 2012 database schema is created based on
Application Object Tree (AOT) definitions, including tables, unique clustered indexes, default constraints, and views. (In previous releases of Microsoft Dynamics AX, the database schema was created during the synchronization step.) Other indexes and check constraints are created on tables after bulk copy but before the post-synchronization scripts run.

This task only creates the target database schema; no data is copied from the source system at this time.

Important:
Before you begin this task, use the Microsoft Dynamics AX Server Configuration Utility to confirm that the AOS statement cache is set to 40.

1. Click Start > Administrative Tools > Microsoft Dynamics AX <version> Server Configuration Utility > Database Tuning.
2. Locate the Statement cache field. Adjust the value if needed.
3. Click OK.

Create the target database schema as follows:

1. In the Data upgrade checklist, click Create tables.
   The Synchronize table form displays a progress bar that indicates the status of the operation while the upgrade framework queries the AOT and determines what tables, fields, and indexes to create in the target database. This process may take several minutes to finish.
2. When the query process is finished, the Synchronize database form opens. Information that was collected during the previous step is displayed on four tabs. You can select items to view details about them.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>Shows what tables need to be created in the target database and summarizes the detailed results provided on the other tabs.</td>
</tr>
<tr>
<td>Errors</td>
<td>Lists errors that occurred while determining what tables to create. You must fix any errors before you proceed with creating tables.</td>
</tr>
<tr>
<td>Warnings</td>
<td>Lists all warnings about possible data conflicts that may arise after tables are created. You should review the warnings and decide which of them require developer action.</td>
</tr>
<tr>
<td>Info</td>
<td>Lists all the tables that will be created in the target database.</td>
</tr>
</tbody>
</table>

Address any errors or warnings before you continue with the data upgrade. Unresolved table errors will cause the data upgrade to fail. After you verify that there are no errors or warnings, click Continue on the Synchronize database form. The upgrade framework creates the tables in the target database.

Generate table mappings
The Generate table mappings task in the Data upgrade checklist creates the mapping between the tables and fields in the Microsoft Dynamics AX source database and the tables and fields that were created in the Microsoft Dynamics AX 2012 database during the Create tables step in the Data upgrade checklist.

Before you start the Generate table mappings task, you must complete the Data upgrade checklist steps Connect to source database and Create tables. If any errors were generated in the Create tables step, you must fix them before you proceed with mapping the tables and fields, otherwise the mapping will be incorrect.
Generate table and field mappings

To generate mapping between tables and fields in the source and target databases, perform the following steps:

1. In the Data upgrade checklist, click Generate table mappings. The upgrade framework begins the mapping process and, when mapping is complete, opens the Table mapping between source and target systems form. This form provides separate tabs where you can see all the tables and fields from the source database and how they are mapped to tables and fields in the target database. You can also view a list of the extended data types that are used in the source fields and have been brought into the target database.

2. Review the mapping on the Tables and Fields tabs in the form and note any errors.

3. Address mapping errors and rerun the Generate table mappings step.

Important:

If you encounter a mapping error, you may need to implement a presynchronization script that defines a mapping for the source table and field. For more information, see the white paper How to write upgrade scripts in Microsoft Dynamics AX 2012.

Customized solutions will frequently cause table mapping errors. For example, the addition of a new extended data type will create an error for every table where it occurs. You will not be able to complete upgrade until you write and implement presynchronization scripts to address schema differences you have introduced.

For testing purposes, it is possible to perform an upgrade on the non-customized portions of your installation and to ignore failed, customized tables using the Continue button on the Table mapping between source and target systems form. The affected tables will not be copied, but the rest of the upgrade can proceed.

You cannot proceed to the next Data upgrade checklist step, Generate upgrade task prioritization, until you address any errors in table and field mapping. If you do, data upgrade on the target system will fail.

Mapping errors

You may encounter the following table-mapping errors for tables that are listed on the Tables tab in the Table mapping between source and target systems form.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Mapping for the table is complete without error.</td>
</tr>
<tr>
<td>No mapping defined</td>
<td>Mapping has not been created because no applicable metadata was found in the Microsoft Dynamics AX 2012 database.</td>
</tr>
<tr>
<td>Field error</td>
<td>An error has occurred that resulted in a source field not being mapped to a target field. The error could be that there is an inconsistency in the field data type, no field to import, or a string-length difference in the field name. You can see which fields have errors on the Fields tab.</td>
</tr>
<tr>
<td>Mapping conflict</td>
<td>Two source-database tables are mapped to the same target table. You must resolve the conflict by renaming the table or assigning it a different ID.</td>
</tr>
<tr>
<td>Waiting on source</td>
<td>A source table is still being used in preprocessing on the Microsoft Dynamics AX source system.</td>
</tr>
<tr>
<td>Target table not empty</td>
<td>The table that was created in the Microsoft Dynamics AX 2012 target database has data in it. The source data cannot be copied into a table that already contains data. Clear all data from the target table.</td>
</tr>
</tbody>
</table>
Generate upgrade task prioritization

Use the Data upgrade checklist item Generate upgrade task prioritization to plan the sequence of bulk copy and post-synchronization script operations during data upgrade. Data upgrade takes place while both the source system and the target system are in single-user mode. Consequently, business operations on Microsoft Dynamics AX are suspended during this time. Bulk copy and script operations, which run concurrently to minimize system downtime, must be prioritized to make the most efficient use of available processing capacity. Microsoft Dynamics AX uses a weighting algorithm to create a default prioritization, though you can use the Prioritized upgrade scripts form to override default priorities as needed to increase efficiency.

Determining task priorities

To preserve data integrity, upgrade tasks must be run in a certain sequence. Upgrade scripts cannot be run until their associated tables have been copied to the Microsoft Dynamics AX target system, and large tables with millions of records take longer than other tables to copy and process. Additionally, dependencies among scripts can result in delays as one script waits for another to finish. The Prioritized upgrade scripts form analyzes all of the upgrade tasks and calculates a prioritization resulting in the least downtime. The prioritization algorithm achieves this by assigning a weight to each task. The weight of a table is based on its physical size and on the number of records. The weight of a script derives from the weight of the tables it updates and on the cumulative weights of all its dependent scripts. In either case, the highest weight results in the highest priority, since heavily weighted jobs are likely to block other jobs until they finish running.

Weight-ranked results are displayed in grids on the Top tables and scripts tab. The Top tables and scripts field contains an integer value that specifies the number of tables and scripts that will be processed concurrently during data upgrade. For example, a value of 20 means that a block of 20 tables and a block of 20 scripts will be run concurrently before proceeding to the next block of 20 and 20. You may achieve efficiency gains by overriding the default value of the Top tables and scripts field. This field also determines the number of top tables and top scripts displayed in their respective grids.

In most cases, the ranking algorithm will produce the best prioritization. However, you can override the algorithm by manually assigning higher or lower weights to tables or scripts and then regenerating the prioritization. Custom priorities are useful when you have knowledge of the actual loads that your system will encounter while upgrading certain tables.

Important:
When you are regenerating the prioritization after assigning custom weights, select "No" if a dialog asks to overwrite your customization.

Adding new tasks

The Prioritized upgrade scripts form allows you to add tables or scripts to the grids manually. To insert an additional table or script, press Ctrl+F3 to create a new row, and then fill in the table or script information. This method can also be used to override the calculated weight of an existing table or script that is not displayed in its grid:

1. Press Ctrl+F3 to create a new row.
2. Enter the name of the table or script whose weight you wish to change.
3. Enter a custom weight.
Launch data upgrade
The Launch data upgrade task opens the Data upgrade cockpit (%1 -> %2), where you can begin bulk copying data from the source Microsoft Dynamics AX system and running data upgrade scripts on the target system.

Run bulk copy and scripts
In the Data upgrade cockpit (%1 -> %2), click Run to perform the bulk copy, run post-synchronization scripts on the copied data, and create check constraints and indexes.

Warning:
Prior to this point in the upgrade process, it has been possible to keep the source system online. Beginning with this step, you must enter single-user mode on both your source and target systems, making them unavailable to regular users.

Post journal for relief of legacy accrual of unmatched quantities
Use this procedure to post a journal that relieves any legacy accrual accounting entries that still remain for unmatched quantities. Unmatched quantities are quantities of purchased products that are received but not yet invoiced. Select the journal name that you have defined during the pre-processing upgrade. After you select the name, post the journal.

Post the journal
1. Check that the journal name is correctly displayed in the Task description field, and then click OK to post the journal. To set up a batch job to post the journal, select a batch group to associate the journal with in the Batch group field and then follow the rest of this procedure.
2. Click Private if you want to make sure that only the user who set up the batch job can run it.
3. Click Batch processing if you want to run the task as a batch job.
4. Click Recurrence and Alerts to define the frequency of the batch job, and whether any alerts should be defined for the job.
5. Click OK to post the journal or start the batch job.

Configure system accounts
Use the System service accounts form to configure the accounts used to run Microsoft Dynamics AX services. Service accounts include the Business Connector proxy account, the Workflow system account, the Workflow execution account, the synchronization service account, and the Bing Maps account.

Configure the Business Connector proxy account
In the Alias and Network domain fields, enter the user name and domain for the Business Connector proxy account. The Business Connector proxy account is used for communication between Microsoft Dynamics AX and other applications.

For more information about the requirements for this account, see Specify the .NET Business Connector proxy account.
Configure the Workflow execution account

The Workflow execution account is used for running application business logic and accessing Microsoft Dynamics AX data. You can use one of the following accounts.

- Enter a domain account in the Alias and Network domain fields to use a domain user for the Workflow execution account.
- Enter a new or existing Microsoft Dynamics AX user to access the database.

For more information about the requirements for this account, see Specify the workflow execution account.

Configure the synchronization service account

The synchronization service account is used for communication between Microsoft Dynamics AX, Windows Message Queuing, and Microsoft Project Server. You can use one of the following accounts.

- Enter a domain account in the Alias and Network domain fields to use a domain user for the synchronization service account.
- Enter a Microsoft Dynamics AX user for the synchronization service to communicate with. You can associate the service with a new or existing Microsoft Dynamics AX user.

For more information about the requirements for the synchronization service account, see Create service accounts.

Configure the Bing Maps account

The Bing Maps account is used to access the online Bing Maps when working in Enterprise Portal. You can find the Bing Maps account name and password on CustomerSource. By selecting the check box and entering the information, you agree to be bound by the Microsoft Bing Maps and MapPoint Web Service End User Terms of Use.

Finalize Enterprise Portal upgrade

The upgrade process can cause the URLs for various Microsoft Dynamics AX web pages to change in the Application Object Tree (AOT). If you upgraded Enterprise Portal, you should select the option to Finalize Enterprise Portal upgrade to make sure that the web pages are synchronized to use the correct URLs.

Specify Role Center web site

Microsoft Dynamics AX and the Enterprise Portal framework include customizable home pages called Role Centers. Role Centers display specific data, reports, alerts, and common tasks that are associated with a user’s role in the organization. Users can access Role Centers from the Microsoft Dynamics AX client or from an Enterprise Portal web site.

Use this information to specify which web site will host the Role Centers.

1. Click the option to Specify Role Center website in the Data upgrade checklist. The Administration of Web sites form opens.
2. Locate the Website used to display Role Centers in the client field at the bottom of this form.
3. Select a site by using the lookup icon to the right of the field and then close the form. If you are not certain which site should host Role Centers, skip this step. You can select the site later by using this form.
4. If no web sites are listed in this form, Enterprise Portal has not been installed or an Enterprise Portal web site has not been created. To learn more, see "Install Enterprise Portal and Role Centers" in the Microsoft Dynamics AX 2012 Installation Guide.

**Assign a primary address to parties**

If a party or customer has been associated with one or more addresses, it is required in Microsoft Dynamics AX 2012 that one address be designated as a primary address. You are not required to define an address for a party. Use this form to assign the first listed address for the party or customer as the primary address when upgrading from Microsoft Dynamics AX 4.0 or Microsoft Dynamics AX 2009.

1. From the Data upgrade checklist click Assign primary addresses to parties to open the Parties without primary addresses form.
2. Review the list of parties. You can manually select the address that you want to designate as the primary address by navigating to the party record.
3. Click the Update addresses button to designate the first address as the primary address for all of the parties that display in the list.

**Upgrade services and AIF**

Application Integration Framework (AIF) is used to exchange data between Microsoft Dynamics AX and external systems. During the upgrade process, the Data upgrade checklist includes a step for the upgrade of AIF code. This topic describes this step of the Data upgrade checklist.

Then, in the checklist pane, click Upgrade AIF code. This step may take a while. When the step is completed, check the Infolog to verify that no errors occurred. This step includes the following two processes:

- **Code upgrade** – This process creates new service classes, data classes, and service nodes in the Application Object Tree (AOT).
- **Data upgrade** – This process upgrades all AIF-related records in the database.

⚠️ **Important:**
The upgrade of AIF code and data is a two-step process. You must successfully upgrade the AIF code before you can upgrade the AIF data. For more information, see Upgrade additional features.

**Before you upgrade**

Before you upgrade, you should be familiar with services and AIF. For more information, see What’s New: Services and AIF.

Review the following sections before you begin the upgrade process.

**Process messages on the source system**

Before you run the upgrade process, make sure that all the AIF messages have been processed on the system that is being upgraded. Check the following locations to verify that all the messages have been processed:

- **All inbound message locations** – These locations include file system directories, Message Queuing queues, and any locations where AIF receives inbound messages.
- **The queue manager** – All messages in the queue manager are unprocessed and must be deleted.
Upgrade considerations

The enhancements to services and AIF in Microsoft Dynamics AX 2012 cause significant changes in functionality, configuration, database schemas, and document schemas, or .xsd files. When you plan an upgrade from an earlier version of Microsoft Dynamics AX, consider the following guidelines:

- You must recompile and test all interfaces that used the earlier version of Microsoft Dynamics AX to make sure that the interfaces work with services in Microsoft Dynamics AX 2012.
- In Microsoft Dynamics AX 2012, the MSMQ and BizTalk adapters are replaced with equivalent functionality that is provided by Windows Communication Foundation (WCF). You must recompile any automated integration processes that used these adapters, such as Microsoft BizTalk Server orchestration.
- The upgrade framework changes AIF endpoints and related configurations to integration ports in Microsoft Dynamics AX 2012. When the upgrade process is completed, you must configure these integration ports before you can use Microsoft Dynamics AX 2012 services and AIF functionality.

Upgrade AIF code

This section describes the process that Microsoft Dynamics AX 2012 uses to upgrade AIF code.

Code upgrade

The step for the upgrade of AIF code upgrades existing Axd <Document> classes and methods. During the code upgrade, the following classes are upgraded:

- The Axd <Document> classes that are included with Microsoft Dynamics AX
- Custom Axd <Document> classes
- Custom classes that implement the AifServicable interface

Data upgrade

During the data upgrade, AIF data in the Microsoft Dynamics AX database is upgraded. Configuration settings for AIF endpoints are copied to configuration settings for integration ports.

Changes made during upgrade

The following table describes how key concepts and configuration settings change when you upgrade from Microsoft Dynamics AX 2009 to Microsoft Dynamics AX 2012.
<table>
<thead>
<tr>
<th>Microsoft Dynamics AX 2009 feature</th>
<th>Microsoft Dynamics AX 2012 feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIF endpoints</td>
<td>Integration ports</td>
<td>The concept of integration ports replaces the concept of AIF endpoints. The <strong>Inbound ports</strong> form and the <strong>Outbound ports</strong> form replace the AIF configuration forms. Endpoints that exposed the Microsoft Dynamics AX functionality are converted to inbound integration ports. Endpoints that submitted messages are converted to outbound integration ports. AIF endpoints become integration ports that have a similar name. The upgrade framework combines the endpoint name and the company name to create the name of the integration port. For example, an endpoint in CompanyB that is named EndpointA becomes an integration port that is named EndpointACompanyB.</td>
</tr>
<tr>
<td>Endpoint constraints</td>
<td>This feature is not converted.</td>
<td>Information about endpoint constraints is not copied to Microsoft Dynamics AX 2012. You must use the legal values framework and the forms for inbound and outbound integration ports to configure constraints. Configure each integration port to apply service and parameter restrictions.</td>
</tr>
<tr>
<td>Endpoint data and action policies</td>
<td>The schema and operation constraints are applied to the integration ports.</td>
<td>Information about data and action policies is not copied. In Microsoft Dynamics AX 2009, data and action policies were applied at the action level. In Microsoft Dynamics AX 2012, data and action policies are applied at the level of the integration port. Therefore, you must use the forms for inbound and outbound integration ports to define your data and action policies after the upgrade.</td>
</tr>
</tbody>
</table>

**Note:**
In earlier versions of Microsoft Dynamics AX, you were required to assign data policies to each endpoint action policy. In Microsoft Dynamics AX 2012, the configuration of data policies is optional.
<table>
<thead>
<tr>
<th>Microsoft Dynamics AX 2009 feature</th>
<th>Microsoft Dynamics AX 2012 feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIF adapters</td>
<td>Integration ports</td>
<td>Information about AIF adapters is not copied. Use the forms for integration ports to associate adapters with integration ports.</td>
</tr>
<tr>
<td>AIF channels</td>
<td>Address of integration ports</td>
<td>Information about AIF channels is not copied. Use the forms for inbound and outbound integration ports to configure the address and response address for each integration port. In earlier versions of Microsoft Dynamics AX, you could associate an endpoint with multiple channels or addresses. In Microsoft Dynamics AX 2012, each integration port has one address for inbound messages and one address for responses.</td>
</tr>
<tr>
<td>AIF pipelines</td>
<td>Integration port pipelines</td>
<td>AIF pipelines are automatically upgraded to integration port pipelines.</td>
</tr>
</tbody>
</table>
| Service code attributes            | Microsoft Dynamics AX 2012 services framework | During the upgrade process, the service code is marked with the appropriate attributes, such as create, read, or find. This step enables the auto-inference feature in Microsoft Dynamics AX 2012 to work with the upgraded code.  

**Important:**  
You must configure each upgraded service to assign appropriate attributes. For more information, see the next row. |
| The configuration is always company-specific. | By default, the configuration is not company-specific. | In earlier versions of Microsoft Dynamics AX, each AIF endpoint was associated with a specific company. In Microsoft Dynamics AX 2012, integration ports do not have to be associated with a specific company. However, you can use the forms for inbound and outbound integration ports to restrict service calls to a specific company. For an inbound message, the services framework retrieves the company ID from the message header. If the message header does not contain a company ID, the services framework uses the default company ID that is associated with the user who submitted the message. |
After you upgrade

After you upgrade, you must configure the `SysEntryPointAttribute` attribute and validate the migration of AIF endpoints.

Configure `SysEntryPointAttribute`

Microsoft Dynamics AX 2012 does not automatically assign the `SysEntryPointAttribute` attribute to service classes that are upgraded. Follow these steps for each service that you are upgrading.

1. In the AOT, expand the `Services` node, and find the service that is being upgraded. Open the `Properties` pane, find the corresponding class name for the service, and make a note of the class name.
2. In the AOT, expand the `Classes` node, and find the entry for the class that you found in the previous step.
3. For each service operation in the class, add a `SysEntryPointAttribute` attribute that uses a value of `true` or `false`. We recommend that you set the value to `true`, so that the service operation accepts the permissions that are assigned to it by the role-based security framework in Microsoft Dynamics AX.

The following example code shows how to add the attribute to the `create` operation of the `SalesSalesOrderService` class.

```csharp
[AifDocumentCreateAttribute, SysEntryPointAttribute(true)]
public AifEntityKeyList create(SalesSalesOrder _salesSalesOrder)
{
    return this.createList(_salesSalesOrder);
}
```

Validate the migration of AIF endpoints

Use the Microsoft Dynamics AX 2012 forms for inbound and outbound integration ports to validate and configure the AIF endpoints that you migrated.

1. Open the Microsoft Dynamics AX client.
2. Initialize AIF to register adapters and services:
   a. Click `System administration > Setup > Checklists > Initialization checklist`.
   b. Expand the `Initialize system` node.
   c. Click `Set up Application Integration Framework`.
3. Open each form for the configuration of integration ports:
   a. Click `System administration > Setup > Services and Application Integration Framework > Inbound ports`.
   b. Click `System administration > Setup > Services and Application Integration Framework > Outbound ports`.
4. Review the list of integration ports to make sure that the AIF endpoints have been migrated as integration ports.
5. For each integration port, validate the migrated settings, and provide any settings that were not migrated:
   a. In the `Address` group, select an appropriate adapter in the `Adapter` field.
   b. Click `Configure` to configure the adapter that you selected.
   c. In the `URI` field, select an appropriate value for the URI.
   d. Expose the service operations. Select `Expose service operations`, and then click `Service operations`.
   e. Manually configure data policies and legal values. Select `Customize documents`, and then click `Data policies`. 
f. Use the **Processing options** FastTab to configure processing settings. Processing settings include settings that control the behavior when errors are encountered in a batch. These settings also control the preprocessing of requests and post-processing of responses.

g. Use the **Troubleshooting** FastTab to configure troubleshooting settings. Troubleshooting settings include settings that control the logging mode and the propagation of errors.

h. Use the **Security** FastTab to configure security settings. Security settings include settings that control restrictions on authorized users and trusted intermediary users. These settings also control whether the integration port is restricted to a specific company.

i. In a browser, open the Microsoft Dynamics AX Web service, and confirm that the Web server returns the WSDL page. Use the following URL to open the Web service:

   net.tcp://AOS_SERVICE_HOST/DynamicsAx/Services/ServiceName?wsdl

   **Note:**
   By default, Microsoft Dynamics AX uses port 8081.

### Compare data upgrade row counts

The **Compare data upgrade row counts** task in the **Data upgrade checklist** checks the data integrity on the Microsoft Dynamics AX 2012 target system following upgrade. Correctly correlated row counts among the source, shadow, and target tables suggest, but do not confirm, that bulk copy and data upgrade finished successfully.

**Warning:**
Row counts are only a preliminary check of data integrity. It is vital to perform more granular checks on data integrity before putting your Microsoft Dynamics AX 2012 system into production.

### Compare source and target row counts

The **Compare data upgrade row counts** form displays related tables as records in a grid. It also provides status figures that report possible problems. At a glance, you can compare table row counts across the upgrade process starting with the source tables, passing to the shadow tables, and ending with the target tables.

Row count is strictly a check on likely success or failure of a table upgrade. When counts fail to match, you should investigate the table involved and the script that processed it. However, even a successful match does not guarantee that the upgrade was successful, and a failed match may not correspond to a problem. To be confident that the upgrade succeeded, you must perform validation tailored to your particular business data.

### Upgrade additional features

The **Upgrade additional features** task in the **Data upgrade checklist** completes the upgrade process for the Application Integration Framework (AIF) and for business intelligence and reporting. When you click the task, the **Data upgrade cockpit ( %1 -&gt; %2)** opens and displays a grid of upgrade jobs that you can run.
Run upgrade jobs
Select the jobs that you want to run and click **Upgrade job**.

**Upgrade Enterprise Portal**
This topic describes how to upgrade Enterprise Portal for Microsoft Dynamics AX. You must meet all of the prerequisites and complete the procedures in this topic to upgrade an Enterprise Portal site to Microsoft Dynamics AX 2012.

**Important details about Enterprise Portal upgrades**
This section describes the changes to Enterprise Portal data, code, pages, and other objects when you run the Microsoft Dynamics AX 2012 **Data upgrade checklist**.

- The **Data upgrade checklist** automatically upgrades Microsoft Dynamics AX 2009 ASP.NET pages to Microsoft Dynamics AX 2012.
- You can upgrade Enterprise Portal from Microsoft Dynamics AX 4.1 to Microsoft Dynamics AX 2012 by using the procedures in this topic. However, the Enterprise Portal framework in Microsoft Dynamics AX 4.1 supported X++ objects, whereas the Enterprise Portal framework in Microsoft Dynamics AX 2012 supports only ASP.NET objects, not X++ objects. After you upgrade to Microsoft Dynamics AX 2012, the **Data upgrade checklist** creates a list of all X++ objects that you must manually convert to ASP.NET before the objects can work with the Enterprise Portal framework in Microsoft Dynamics AX 2012.
- The **Data upgrade checklist** does not change any Enterprise Portal parameters.
- The **Data upgrade checklist** and Enterprise Portal Setup manage all changes to the Web.config file. If your earlier implementation of Enterprise Portal was configured to connect to a different Application Object Server (AOS) by using an .axc file, this configuration is upgraded automatically.
- Enterprise Portal Setup automatically upgrades themes and style sheets. If you modified a style sheet for your earlier implementation of Enterprise Portal, merge the changes when you run the **Data upgrade checklist**, before you run Enterprise Portal Setup.
- The **Data upgrade checklist** identifies proxy files and user controls that must be updated before they can work with Enterprise Portal for Microsoft Dynamics AX 2012. You must resolve code differences in the proxy files and recompile user controls so that the proxy files and user controls work with Enterprise Portal.
- Settings for end user personalization and customization of Enterprise Portal must be reset after the upgrade.

**Before you upgrade**
You must complete the following tasks before you upgrade Enterprise Portal. Otherwise, the upgrade fails.

1. Use Internet Information Services (IIS) manager to configure the site for Integrated Windows authentication, or NTLM authentication. The upgrade process for Enterprise Portal fails if an Enterprise Portal site is configured to use anonymous authentication. After the site is upgraded, you can configure the site for anonymous authentication. For information about how to configure authentication in IIS, see the online documentation for IIS.
2. You must complete the Microsoft Dynamics AX 2012 **Data upgrade checklist** before you upgrade Enterprise Portal. The **Data upgrade checklist** makes important changes to data and Enterprise Portal objects. These changes are described later in this topic.
3. If your Enterprise Portal sites are running Microsoft Dynamics AX 4.0 or earlier versions, you must upgrade to Microsoft Dynamics AX 4.1 before you can upgrade to Microsoft Dynamics AX 2012.
4. Enterprise Portal for Microsoft Dynamics AX 2012 requires either Microsoft SharePoint Foundation 2010 or Microsoft SharePoint Server 2010. You must upgrade earlier versions of SharePoint to one of these versions before you upgrade Enterprise Portal. For more information, see Upgrading to SharePoint Foundation 2010 or Upgrading to SharePoint Server 2010.

Upgrade Enterprise Portal
This section describes how to upgrade an Enterprise Portal site. You must complete the procedures in this section in the following order:
1. Use SharePoint Central Administration to create a new Web application.
2. Install Enterprise Portal on the new Web application.
3. Attach the content database from your Microsoft Dynamics AX 2009 Enterprise Portal site to the new Web application.
4. Resolve URL conflicts.
5. Reinstall Enterprise Portal to start the code upgrade.

Create a new Web application
Use SharePoint 2010 Central Administration to create a new Web application. For more information, see Create a Web application (SharePoint Server 2010).

Install Enterprise Portal on the new Web application
Use the following procedure to install Enterprise Portal on the new Web application.
1. Start Microsoft Dynamics AX Setup.
2. Advance through the first wizard pages.
3. On the Modify Microsoft Dynamics AX installation page, select Add or modify components. Click Next.
4. On the Add or modify components page, expand Server Components, expand Web Server Components, and then select Enterprise Portal (EP). Click Next.
5. On the Specify Business Connector proxy account information page, enter the domain\username and password for the service account. Click Next.
7. Select the Configure for Windows SharePoint Services option so that Setup can configure the application pool to run under the Business Connector proxy account. Setup can also set the authentication method to Windows NTLM.
8. Clear the Create Web site option. If you select this option, Setup upgrades your Microsoft Dynamics AX 2009 Enterprise Portal site and creates an additional site.
10. Complete the wizard. Setup can take up to one hour to complete the upgrade and installation.
Attach the content database from your Microsoft Dynamics AX 2009 Enterprise Portal site to the new Web application

To retain content from an earlier version of Enterprise Portal and display that content in your Microsoft Dynamics AX 2012 Enterprise Portal site, you must attach the old content database to your new Web application. For more information, see Attach databases and upgrade to SharePoint Server 2010.

Resolve URL conflicts

If you specified a new port number or a new computer name when you created the new Web application, the URL of the Enterprise Portal site was changed. If the URL has been changed, you must delete the old site in the Microsoft Dynamics AX client by using the Web sites form.

After you delete the old site, click Register site, and then enter the information about the new site. Repeat this process until you have registered each site. If you need help finding information about your sites, open SharePoint Central Administration, and then click Application Management > View all site collections. If necessary, use the Web Application list to select the application that hosts your Enterprise Portal sites.

Reinstall Enterprise Portal to upgrade the code

Reinstall Enterprise Portal on the new Web application so that the site upgrades the Enterprise Portal code. Repeat the installation process that is described earlier in this topic.

After you upgrade Enterprise Portal

After the installation and upgrade are finished, follow these steps:

1. If you upgraded an Enterprise Portal site that uses anonymous authentication, and you configured the site for Integrated Windows, or NTLM, authentication at the start of the upgrade process, you can now reconfigure the site for anonymous authentication. For information about how to configure authentication, see the online documentation for IIS.
2. Verify that existing permissions for SharePoint and Microsoft Dynamics AX were retained during the upgrade process.
3. Test the upgraded site on a staging server before you move the site into a production environment.
Test the system after upgrade

After you finish upgrade, test whether your Microsoft Dynamics AX 2012 installation is functioning properly.

To test whether upgrade succeeded, perform (at a minimum) these tasks:

- Restart all Application Object Server (AOS) instances.
- Launch a client that is connected to each AOS instance that is running.
- Test that users can execute the most common tasks for your system.
- Test that the administrator can run the system maintenance tasks.
- Test that developers can create a new development workspace and create code projects.
- Test that users can execute the most vital tasks for your installation.
- Test that users can read the reports that are generated.
- Test that the security roles are working correctly. Users in Microsoft Dynamics AX 2012 should have access to the data they had access to on the source system and they should be able to do all the tasks for their assigned roles.
- Validate that your Microsoft Dynamics AX 2012 data is consistent with the Microsoft Dynamics AX source system data prior to upgrade.
- Verify that features that required code upgrade function as expected on the new system.